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Ëw¿t ËthMð‚ ðt[fr{ºttu,
Ëti™u ™{Mfth. ¼th‚™e ºtý {nt™ rð¼qr‚ rðï{tk ÷tufniÞu {t™ðk‚w MÚtt™ y™u ËL{t™

…t{e Au : Mðt{e rððuft™kŒ, {ntí{t „tkÄeS y™u ztì. Ëðo…Õ÷e htÄtf]»ý™T. ¼th‚eÞ
ËkMf]r‚™t …whMf‚to, ¼th‚™t …qðo ht»xÙ…r‚, {nt™ rV÷tuËtuVh, fu¤ðýefth, ytSð™ rþûtf
y™u ‘¼th‚hí™’ ztì. Ëðo…Õ÷e htÄtf]»ý™T™u ‚u{™t sL{rŒ™-rþûtfrŒ™u ðkŒ™ fhe™u ‚u{™t
Sð™, fð™, rþûtýŒþo™ y™u ytŒþtuo™u y™wËhðt™tu rŒðË yux÷u …tk[{e ËÃxuBƒh.

‘Ý çã ¿ææÝïÝ ¨Îëàæ¢ Ðç±~æç}æã ç±l„ï J’ (‘¿tt™Úte ðÄw [rzÞt‚wk fu …rðºt ƒeswk ftkE ™Úte.’)
yu yu{™tu Sð™{kºt n‚tu. rþûtý y™u fu¤ðýe rð»tÞf ‚u{™t rð[thtu™e ™tUÄ ytsu …ý
÷uðtÞ Au. ‚uytuyu fÌtwk Au fu : “rþûtý y™u fu¤ðýe™wk ft{ W¥t{ {t™ðe™wk r™{toý fhðt™wk
Au. Ët[e fu¤ðýe {tºt ¿tt™, {trn‚e y™u nfef‚tu™e ™rn …hk‚w ÔÞÂõ‚{tk Sð™{qÕÞtu,
Sð™ftiþÕÞtu, {t™ð‚t, ËkMfth½z‚h y™u [trhºÞ™wk r™{toý fh™the ntuðe òuEyu. ƒt¤ftu
rs¿ttËw ƒ™e «&™tu …qA‚tk ÚttÞ, ËkþtuÄ™ð]r¥tðt¤tk ÚttÞ, ™ðe ™ðe ðM‚wytu þe¾u y™u
Ëso™þe÷ ƒ™u ‚uðwk rþûtý ƒt¤ftu™u {¤ðwk òuEyu. rþûtf Ë{ts™tu ¾htu ½zðiÞtu y™u ht»xÙ™tu
ytÄthM‚k¼ Au. ¼th‚™t ¼trð ™t„rhf yuðtk ƒt¤ftu{tk ËkMfthtu, [trhºÞ, Œuþ¼Âõ‚ huzðt™wk
ftÞo rþûtf™wk Au.”

…tk[{e ËÃxuBƒh-rþûtfrŒ™ yu ©uc rþûtftu™u rƒhŒtððt™tu …rðºt rŒðË Au. xt„tuh ntì÷,
…t÷ze, y{ŒtðtŒ ¾t‚u {t™™eÞ {wÏÞ{kºte©e ¼q…uLÿ¼tE …xu÷ ‚u{s {t™™eÞ rþûtý{kºte
©e ztì. fwƒuh¼tE ®zztuh îtht htßÞ™t yt ð»to™t fw÷ 30 ©uc yt[tÞo-rþûtftu™wk þt÷ y…oý
fhe, «{tý…ºt y™u …whMfth yu™tÞ‚ fhe™u ¼tð¼e™wk ËL{t™-yr¼ðtŒ™ fhðt{tk ytÔÞwk n‚wk.
{t™™eÞ {wÏÞ{kºte©e ¼q…uLÿ¼tE …xu÷u yt «Ëk„u sýtÔÞwk fu - “Sð™½z‚h{tk {t‚t-r…‚t
…Ae rþûtf™wk Þtu„Œt™ {n¥ð™wk Au. yu{tk ÷tune™tu ™rn …ý ðtíËÕÞ™tu ËkƒkÄ ntuÞ Au. yts™wk
ƒt¤f ytð‚e ft÷™tu ™t„rhf Au. rðãtÚteoytu{tk ‘MðŒuþe’ y™u ‘ht»xÙ «Út{’™tu ¼tð fu¤ðe
{t™™eÞ ðzt«Ät™©e ™huLÿ {tuŒe™t ‘ytí{r™¼oh’ ¼th‚™t rðÍ™™u rþûtfË{wŒtÞ Ëtfth fhu.
yts™t rŒ™u ©uc rþûtf ËL{t™ yu ‘htRx òìƒ yux htRx xtR{’ Au.”

yt ftÞo¢{{tk htßÞ™t …tk[ «r‚¼tþt¤e rðãtÚteoytu™u {t™™eÞ {wÏÞ{kºte©e y™u
{t™™eÞ rþûtý{kºte©e™t ðhŒTnM‚u «{tý…ºttu yu™tÞ‚ fhðt{tk ytÔÞt n‚t. ‚u ‚{t{™u
yr¼™kŒ™ …tXðwk Awk. htßÞfûtt™tu ©uc rþûtf™tu …whMfth {u¤ð™th «tÚtr{f, {tæÞr{f y™u
Wå[‚h {tæÞr{f rð¼t„™t ‚{t{ ©uc yt[tÞtuo ‚Útt rþûtftu™t þiûtrýf, Ët{trsf,
Ëso™tí{f ‚u{s ËkþtuÄ™tí{f ftÞtuo™e ™tUÄ ÷E ‚u{™u rƒhŒtðwk Awk. þt¤tytu{tk rþûtf™e yuf
rŒðË™e ¼qr{ft ¼sðe™u ‘MðÞkrþûtfrŒ™’™e Wsðýe{tk Ën¼t„e Út™th ‚{t{ ƒt¤ftu™u
ÄLÞðtŒ …tXðwk Awk. þt¤tytu îtht ÷uðt™th yt„t{e «Út{ Ëºttk‚ …heûtt™e …Ør‚Ëh™e ‚Útt
…whw»ttÚto¼he …qðo‚iÞthe rðãtÚteoytu fhu ‚u {txu rþûtftu îtht ‚uytu™u {t„oŒþo™ yt…ðt{tk ytðu
‚u {txu y™whtuÄ fhðt{tk ytðu Au.

yt„t{e Ë{Þ{tk ytð™th ™ðhtrºt ‚Útt rŒðt¤e™t ‚nuðthtu™e yt… Ëti™u þw¼ft{™t
…tXðwk Awk.

yæÞût™e f÷{u...

{wfuþ …kzât
‚t. 20-09-2025 yæÞût

{tæÞr{f

rþûtý

…heûtý

y™u
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‚kºte MÚtt™uÚte...

Ëw¿t ËthMð‚ yt[tÞor{ºttu ‚Útt rþûtf ¼tE-ƒnu™tu,
Ëti™u M™un¼Þto ðkŒ™. ‘{tæÞr{f rþûtý y™u …heûtý’™tu ËÃxuBƒh, 2025™tu yt ykf yt… Ëti

ËthMð‚ ðt[fr{ºttu Ë{ût «M‚w‚ fh‚t ‚kºte{kz¤ yt™kŒ™e ÷t„ýe y™w¼ðu Au.
¼th‚eÞ ËkMf]r‚{tk Ér»t{wr™ytu, „whws™tu ‚Útt Ëk‚tu ËtÚtu rþûtf™wk MÚtt™ nk{uþtk ytŒhýeÞ y™u

ËL{t™™eÞ hÌtwk Au. ftuE…ý Ë{ts, htßÞ fu ht»xÙ fuðt Au ‚u™tu {wÏÞíðu ytÄth ‚u™t rþûtftu fuðt
f{or™c, ðVtŒth y™u ©uc Au ‚u™t …h Au. ht»xÙ™t ½z‚h™e ¼qr{ft{tk hnu÷t rþûtf™e sðtƒŒthe
Œuþ¼õ‚ Ëir™f suðe Au. rþûtý{tk „wýð¥ttð]rØ y™u ËwÄthýt ËtÚtu ‘ðìÕÞw yìLz Mfe÷ zuð÷…{uLx’™e
f…he ft{„ehe …ý rþûtf-yæÞt…f™t rþhu hnu÷e Au. ‚uÚte fnuðtÞwk Au fu - “Ëtht rþûtf ƒt¤ftu™u
Ëthe Ë{sý yt…u Au, ©uc rþûtf …qh‚wk {t„oŒþo™-r™Œþo™ fhu Au. ßÞthu ztì. Ëðo…Õ÷e htÄtf]»ý™T
suðt {nt™ rþûtftu™t Sð™-ftÞtuo Ëti™u «uhýt yt…u Au.” rþûtftu {txu Œhuf rŒðË yu …tu‚t™e ÷tÞft‚
ðÄthðt™e y™u Ë{ts{tk ©uc ƒ™ðt™e yuf yËtÄthý y™u y{qÕÞ ‚f Au. ¼th‚™e ‚u{s rðï™e
{nt™ rð¼qr‚ytu™t ½z‚h{tk ‚u{™t {t‚t-r…‚t ‚Útt rþûtftu™tu Vt¤tu ðÄw hnu÷tu Au.

rþûtfyt÷{ «íÞu Ë{ts, htßÞ y™u ht»xÙ{tk ytŒh-{t™™e ¼tð™t sL{u ‚Útt ‚uytu …tu‚t™t
…rðºt rðãtÄ{o™u y™wËhu y™u rþûtý™t ÔÞðËtÞ ûtuºtu ðVtŒth y™u «t{trýf ƒ™u yu nu‚wÚte Œh ð»tuo,
…tk[{e ËÃxuBƒhu ztì. Ëðo…Õ÷e htÄtf]»ý™T™t sL{rŒ™™e ÞtŒ{tk ‘rþûtfrŒ™’™e Wsðýe ÚttÞ Au.
‘¼th‚hí™’ yìðtuzoÚte rð¼qr»t‚ y™u {nt™ ‚¥ð®[‚f, rðïrþûtf, fu¤ðýefth y™u ¼th‚™t …qðo
W…ht»xÙ…r‚ y™u ht»xÙ…r‚ ztì. Ëðo…Õ÷e htÄtf]»ý™u Ëti™e ÷t„ýe y™u {t„ýe™u {t™ yt…e™u …tu‚t™tu
sL{rŒ™ ‘rþûtfrŒ™’ ‚hefu WsðtÞ yuðe ðt‚ fhe™u, Ë{„ú rþûtfyt÷{™u Ÿ[tu Ët{trsf {tu¼tu
ytÃÞtu Au. òu …tu‚t™t{tk ¿tt™, ût{‚t, «r‚¼t, ytðz‚, ftiþÕÞ ntuÞ ‚tu rþûtf …ý Äthu ‚tu ht»xÙ…r‚
…Œ suðwk ËL{t™ …t{e þfu Au yu yu{™t Sð™ y™u fð™ îtht …h¾tÞ Au.

yt ð»tuo …tk[{e ËÃxuBƒhu rþûtfrŒ™u xt„tuh ntì÷, …t÷ze, y{ŒtðtŒ ¾t‚u {t™™eÞ {wÏÞ{kºte©e
¼q…uLÿ¼tE …xu÷ ‚u{s {t™™eÞ rþûtý{kºte©e ztì. fwƒuh¼tE ®zztuh îtht „wsht‚™t 30 ©uc rþûtftu™wk
ònuh{tk ËL{t™-yr¼ðtŒ™ fhðt{tk ytÔÞwk n‚wk. htßÞ™t «tÚtr{f, {tæÞr{f y™u Wå[‚h {tæÞr{f
rð¼t„™t yt ©uc yt[tÞtuo ‚Útt rþûtftu™wk ËL{t™ fh‚tk {t™™eÞ rþûtý{kºte©e fwƒuh¼tE ®zztuhu
©ef]»ý, [týõÞ, rð™tuƒt ¼tðu y™u ftft ft÷u÷fh™t WŒtnhý yt…e sýtÔÞwk fu “¼th‚eÞ ËkMf]r‚™t
rðftË{tk „whwSytu™wk «Œt™ {n¥ð™wk hÌtwk Au. A.I.Úte ‚t÷e{ yt…e þftÞ …ý rðãtÚteoytu{tk ËkMfthtu™wk
®Ë[™ ‚tu rþûtfÚte s ÚttÞ. rþûtf™e ¼qr{ft ftÞ{e y™u Sðk‚ Au.” 5, ËÃxuBƒhu ËL{tr™‚ ÚtÞu÷t
yt ‚{t{ ©uc rþûtftu™u yºtuÚte rƒhŒtðe ÄLÞðtŒ …tXðwk Awk.

þiûtrýf ð»to : 2025-26Úte Ätu. 9 Úte 12{tk fux÷tf rð»tÞtu™t «&™…ºt-…rhY…{tk VuhVth ÚtÞt
Au. yu {wsƒ ƒtuzo îtht rð»tÞðth ™{q™t™tk «&™…ºttu ‚iÞth fhe™u «rËØ fhðt{tk ytÔÞtk Au.
rð»tÞrþûtftuyu ‚u™tu yÇÞtË fhe™u, rðãtÚteoytu™u ‚u yk„u {trn‚„th fhðt y™u yu {wsƒ þt¤t-
…heûttytu™tk «&™…ºttu™tu {ntðhtu fhtððt™tu hnuþu.

yt ð»tuo 11 Úte 20 ËÃxuBƒh, 2025 Œhr{Þt™ þt¤tfûttyu yuf{ fËtuxe ÷uðtE Au. ‚u{s
ytìõxtuƒh {tË{tk Ätu. 9 Úte 12™e þt¤t fûttyu ‘«Út{ Ëºttk‚’ …heûtt ÷uðt™th Au íÞthu …heûtt yk„u
rðãtÚteoytu™u …qh‚wk {t„oŒþo™ yt…ðt rð™k‚e Au. …heûtt …Ae W¥thðneytu™wk {qÕÞtkf™ fhe™u ðt÷eytu™u
W¥thðneytu ƒ‚tððt™tu ftÞo¢{ ÞtuòÞ, ™ƒ¤tk ƒt¤ftu™u «tuíËtn™ ËtÚtu ðÄw {t„oŒþo™ y…tÞ y™u
‚usMðe ƒt¤ftu™u rƒhŒtðtÞ yuðtu ftÞo¢{ þt¤t fûttyu Þtusðt yt[tÞo©eytu™u y™whtuÄ Au. yt ykf{tk
Ätu. 10 y™u 12™t fBÃÞqxh yæÞÞ™ y™u Ätuhý 12™t yÚtoþtMºt rð»tÞ™t ™{q™t™tk «&™…ºttu Ëti™t
yÇÞtË {txu {qõÞtk Au, su™tu ÷t¼ ÷uðt Ëti™u y™whtuÄ Au.

yth. yth. ÔÞtË
‚t. 20-09-2025 Ër[ð/‚kºte

{tæÞr{f

rþûtý

…heûtý

y™u
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1. …heûtý rð¼t„ : Ëkf÷™

Ätuhý-10 y™u Ätuhý-12 ™t yÇÞtË¢{™wk

{tËðth ytÞtus™, «&™…ºt …rhY… y™u

™{q™t™t «&™…ºttu :

• Ätuhý-10 : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f y™u «tÞtur„f) 4

• Ätuhý-12 : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f y™u «tÞtur„f) 12

• Ätuhý-12 : yÚtoþtMºt 25

2. ðneðxe rð¼t„ : Ëkf÷™ 32

…rh…ºt : þiûtrýf ð»to 2025-26 {txu Ätuhý-10™t
rð»tÞ{t¤¾t{tk ðtìfuþ™÷ rþûtý™t rð»tÞ™t Ë{tðuþ ƒtƒ‚.

y™w¢{rýft

y.™k. rð»tÞ  ÷u¾f …t™t ™k.
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¢{ {tË «fhý                «fhý™wk ™t{ ykŒtrs‚

¢{ ‚tË

1. sq™ 1. HTML™tu …rh[Þ 08

2. HTML{tk Head y™u Body rð¼t„ (y…qýo) 03

2. sw÷tE 2. HTML{tk Head y™u Body rð¼t„ (…qýo) 06

5. fuÕËe™tu …rh[Þ 07

6. fuÕËe{tk zuxt™wk yìrz®x„ y™u Vtu{uo®x„ 08

3. ytì„Mx 7. fuÕËe{tk rðÄuÞ 14

4. ËÃxuBƒh 9. Ë{MÞt y™u Ë{MÞt™wk r™htfhý 08

5. ytìõxtuƒh 10. Ëe ¼t»tt™tu …rh[Þ 06

6. ™ðuBƒh 11. Ëe ¼t»tt{tk zuxt«fth, «r¢Þftu y™u …Œtðr÷ytu 06

12. r™ðuþ (Input)/r™„o{ (Output) «r¢Þtytu™tu W…Þtu„ 06

7. rzËuBƒh 13. r™ýoÞ {t¤¾tk 06

14. ÷q… r™Þkºtý {t¤¾tk 09

8. òLÞwythe -- Revision --

9. Vuƒúwythe -- Revision --

s„ Au yu™wk {qf …heûtf, [t÷u ‚u™wk Ë‚‚ …heûtý,
™u ™t ÚttÞu …qhwk rþûtý, su™tu nwk Awk rþûtf.     – W{tþkfh òuþe

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-10
 rð»tÞ : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f (24) y™u «tÞtur„f (25))

yÇÞtË¢{™wk {tËðth ytÞtus™
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rþûtý

…heûtý

y™u

nu‚wytu «{týu „wý¼th :
nu‚wytu ¿tt™ (K) Ë{s (U) W…Þtus™ (A) ftiþÕÞ (S) fw÷
„wý 15 15 15 5 50

xft(%) 30% 30% 30% 10% 100%
frX™‚t{qÕÞ …h™tu „wý¼th

¢{tkf  frX™‚t™wk M‚h frX™‚t{qÕÞ „wý¼th «&™tu™wk MðY… nu‚w÷ûte (MCQ)
1. Ëh¤ 50% 25 «&™tu™e ËkÏÞt 50
2. {æÞ{ 35% 18 Vt¤ðu÷ „wý 50
3. frX™ 15% 7 ykŒtrs‚ Ë{Þ 1.30 f÷tf

fw÷ 100% 50
«fhý y™wËth „wý¼th™e Vt¤ðýe

¢{ «fhý ¢{ «fhý™wk ™t{ ËiØtkr‚f „wý¼th «tÞtur„f „wý¼th
1. 1 HTML™tu …rh[Þ 6 8
2. 2 HTML{tk Head y™u body rð¼t„ 7 7
3. 5 fuÕËe™tu …rh[Þ 3 4
4. 6 fuÕËe™tu …rh[Þ{tk zuxt™wk yìrz®x„ y™u

Vtu{uo®x„ 4 6
5. 7 fuÕËe{tk rðÄuÞ 5 5
6. 9 Ë{MÞt y™u Ë{MÞt™wk r™htfhý 3 –
7. 10 Ëe ¼t»tt™tu …rh[Þ 4
8. 11 Ëe ¼t»tt{tk zuxt«fth, «r¢Þftu y™u

…Œtðr÷ytu 6 10
9. 12 r™ðuþ (Input)/r™„o{ (Output)

«r¢Þtytu™tu W…Þtu„ 4
10. 13 r™ýoÞ {t¤¾tk 4 10
11. 14 ÷q… r™Þkºtý {t¤¾tk 4

fw÷ 50 50

™tUÄ™tUÄ™tUÄ™tUÄ™tUÄ ::::: yt …rhY… rðãtÚteoytu, rþûtftu, «tr&™ftu, {tuzhuxËo ð„uhu™t {t„oŒþo™ {txu Au. su ‚u rð»tÞtu™t «tr&™f ‚u{s
{tuzhuxËo™u {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtý™t ƒ]nŒT ntŒo/WÆuþ™u ËwËk„‚ hne «&™…ºt™e Ëkh[™t ƒtƒ‚u
VuhVth fhðt™e Aqx hnuþu.

“yuf …qýo rþûtf yux÷u ƒt¤ftu {txu nh‚e-Vh‚e ÷tEƒúuhe.” – Mðt{e ËÂå[Œt™kŒ

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-10
rð»tÞ : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f (24) y™u «tÞtur„f (25))

ðtŠ»tf …heûtt
Ë{Þ : 1.30 f÷tf «&™…ºt™kw …rhY… „wÛt : 50
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«fhýðth „wý¼th«fhýðth „wý¼th«fhýðth „wý¼th«fhýðth „wý¼th«fhýðth „wý¼th

«fhý«fhý«fhý«fhý«fhý «fhý™wk ™t{«fhý™wk ™t{«fhý™wk ™t{«fhý™wk ™t{«fhý™wk ™t{ ¿tt™¿tt™¿tt™¿tt™¿tt™(K) Ë{sË{sË{sË{sË{s(U) W…Þtus™W…Þtus™W…Þtus™W…Þtus™W…Þtus™(A) ftiþÕÞftiþÕÞftiþÕÞftiþÕÞftiþÕÞ(S) fw÷fw÷fw÷fw÷fw÷

f{f{f{f{f{ «&™™tu «fth«&™™tu «fth«&™™tu «fth«&™™tu «fth«&™™tu «fth MCQ MCQ MCQ MCQ „wý„wý„wý„wý„wý

1 HTML™tu …rh[Þ 1 2 3 0 6

2 HTML{tk Head y™u body rð¼t„ 3 2 1 1 7

5 fuÕËe™tu …rh[Þ 1 1 1 0 3

6 fuÕËe{tk zuxt™wk yìrz®x„ y™u Vtu{uo®x„ 1 1 1 1 4

7 fuÕËe{tk rðÄuÞ 1 1 2 1 5

9 Ë{MÞt y™u Ë{MÞt™wk r™htfhý 1 1 1 0 3

10 Ëe ¼t»tt™tu …rh[Þ 1 1 1 1 4

11 Ëe ¼t»tt{tk zuxt«fth, «r¢Þftu y™u
…Œtðr÷ytu 2 2 1 1 6

12 r™ðuþ/r™„o{ «r¢Þtytu™tu W…Þtu„ 2 1 1 0 4

13 r™ýoÞ {t¤¾tk 1 2 1 0 4

14 ÷q… r™Þkºtý {t¤¾tk 1 1 2 0 4

15 15 15 5 50

“rþûtf f¼e ËtÄthý ™nª ntu‚t, «÷Þ ytih r™{toý W™fe „tuŒ {U …÷‚u ni.” – [týõÞ

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-10
rð»tÞ : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f) (24)

™{q™t™t «&™…ºt™e çÕÞqr«Lx
Ë{Þ : 1:30 f÷tf „wÛt : 50
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„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-10
rð»tÞ : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f) (24)

ðtŠ»tf …heûtt
Ë{Þ : 1:30 f÷tf ™{q™t™wk «&™…ºt „wÛt : 50

1. ðuƒ™e {trn‚e Œþtoððt {txu fE {tfoy… ¼t»tt™e sYh …zu Au ?

(A) CML (B) HTML

(C) NML (D) WML

2. HTML ŒM‚tðus{tk fux÷t xtEx÷ yìr÷{uLx ntuÞ Au ?

(A) yuf (B) ƒu
(C) ºtÛt (D) [th

3. HTML{tk ™e[u™t{tkÚte fÞwk ¾t÷e (Empty) xu„™wk WŒtnhÛt Au ?

(A) <H1> (B) <P>

(C) <Br> (D) <Pre>

4. HTML{tk ™¬e fhu÷ ÷¾tÛt™u Îttxt yûthtu{tk ht¾ðt {txu fÞt xu„™tu W…Þtu„ fhtÞ Au ?

(A) <tt> (B) <B>

(C) <l> (D) <sup>

5. HTML ŒM‚tðus™e ykŒh fux÷tf yûthtu fu þçŒtu™tu Ë{qn fu su y÷„ hk„Úte (Ët{tLÞ he‚u ¼qht hk„Úte)
y™u ™e[u ÷exe Œtuhe™u ŒþtoðtÞ Au ‚u™u þwk fnu Au ?

(A) E{us r÷kf (B) „wÛtÄ{o
(C) ntR…h r÷kf (D) r«Vtu{uoxuz

6. HTML yur÷{uLx™e ËtÚtu ðÄtht™e „tuXðÛt fhðt ™e[u™t{tkÚte þwk W…Þtu„{tk ÷uðtÞ Au ?

(A) ËkÏÞt (™kƒh) (B) „wÛtÄ{o (yuxÙeçÞwx)
(C) rxÃ…Ûte (ftu{uLx) (D) ÷¾tÛt (fLxuLx)

7. ™e[u™t{tkÚte fÞt ƒu, HTML ftuz™t ƒu, {q¤¼q‚ rð¼t„tu ƒ™tðu Au ?

(A) Head y™u Body (B) Physical y™u Logical

(C) Code y™u Browser (D) Meta tags y™u Body

Ëq[™tytu :
• Œhuf «&™™tu 01 „wý Au.
• s{ýe ƒtsw™t ytkfzt «&™™t fw÷ „wý Œþtoðu Au.

“{thwk {tÚtwk ƒu ÔÞÂõ‚™u ™{u Au : yuf rþûtf™u y™u ƒeò ¾uzq‚™u.”   – y™t{e
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8. HTML ftuz{tk xu„ Œþtoððt {txu ™e[u™t{tkÚte þwk W…Þtu„{tk ÷uðtÞ Au ?
(A) Ëtu¤ ykf™e …jr‚{tk f÷h ftuz (B) Œþtkþ …jr‚{tk f÷h ftuz
(C) f÷h r{rfËk„ {tuzu÷ (D) xftðthe{tk r{fËu÷

9. HTML{tk ¾t™t™u Ë{tk‚h ytze ÷exe Œtuhðt {txu ™e[u™t{tkÚte fÞt yìr÷{uLx™tu W…Þtu„ ÚttÞ Au ?
(A) <In> (B) <line>
(C) <hr> (D) <rular>

10. yûth MðY…tkf™ {txu™e ™e[u™t{tkÚte fE ¼tir‚f xu„™e ðå[u xtE… fhu÷ ÷¾tÛt™u ‚u™e yt„¤™t ÷¾tÛt
fh‚t ™t™t yûthtu{tk y™u Úttuzwk W…h Œþtoðu÷ Au ?
(A) <sub>...</sub> (B) <lt>...</lt>
(C) <strike>...</strike> (D) <sup>...</sup>

11. ™e[u™t{tkÚte fÞtu HTML{tk <FONT> xu„™tu „wÛtÄ{o ™Úte ?
(A) face (B) size
(C) type (D) color

12. HTML{tk ‘&’ r[nT™ {txu ™e[u™t{tkÚte fE Ëtkfur‚f Ëk¿tt™tu W…Þtu„ fhðt{tk ytðu Au ?
(A) lt (B) gt
(C) cmp (D) and

13. HTML{tk fÞtu xu„ yt¾t ðuƒ …us {txu™t Ët{tLÞ (default) VtuLx ÔÞtÏÞtrÞ‚ fhu Au ?
(A) <base (B) <basefont>
(C) <default> (D) <body>

14. fuÕËe{tk ƒ™tðu÷e ðfoþex™wk y™w÷kƒ™ ™e[u™t{tkÚte þwk ntuÞ Au ?
(A) .ods (B) .odd
(C) .xls (D) .obj

15. fuÕËe{tk sYrhÞt‚ «{tÛtu xq÷ƒth™u «Œrþo‚ fhðt {txu fÞt {u™w rðfÕ…™tu W…Þtu„ ÚttÞ Au ?
(A) File -> Toolbars (B) Edit --> Toolbars
(C) View ==> Toolbars (D) Format --> Toolbars

16. fuÕËe{tk ðfoþex™t ftuE…Ût Ëu÷{tk Ëqºt Œt¾÷ fhðt {txu Ëqºt™e þYyt‚{tk fÞwk r[nT™ ÷¾ðwk
sYhe Au ?
(A) * (B) /
(C) % (D) =

17. fuÕËe{tk ™ðe M«uzþex ¾tu÷ðt {txu fE þtuxo fx fe™tu W…Þtu„ ÚttÞ Au ?
(A) ctrl + S (B) ctrl + O
(C) ctrl + N (D) ctrl + T

18. fuÕËe{tk r™h…uût MÚtt™tkf fhðt {txu ™e[u™t{tkÚte fÞt r[nT™™tu W…Þtu„ ÚttÞ Au ?
(A) + (B) =
(C) $ (D) &

¼ÛÞt s ™rn {tºt, rfL‚w {ws™u ¼ýtÔÞt ‚{u,
‚{u s „whw, rþ»Þ nwk, rþh ËŒið yuÚte ™{u. – r™hks™ ¼„‚
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19. fuÕËe{tk {ŒŒ {u¤ððt {txu ™e[u™t{tkÚte fE Vkfþ™ fe™tu W…Þtu„ ÚttÞ Au ?
(A) F1 (B) F2
(C) F4 (D) F7

20. fuÕËe{tk rƒ™sYhe zuxt™u „t¤e™u Œqh fhðt™e «r¢Þt™u þwk fnu Au ?
(A) Ëtu‹x„ (B) Ër[ok„
(C) rVÕxrhk„ (D) ðu÷ezurxk„

21. fuÕËe{tk ™e[u™t{tkÚte fÞwk „trÛtr‚f rðÄuÞ yt…u÷ ËkÏÞt™e ¢r{f rðÄuÞ™e rfk{‚ …tAe yt…u Au ?
(A) sum() (B) product()
(C) sort() (D) fact()

22. fuÕËe{tk =int(15.3) rðÄuÞ fE ®f{‚ …h‚ fhþu ?
(A) 15 (B) 3
(C) 15.0 (D) 0.3

23. fuÕËe{tk fÞwk ytkfztfeÞ rðÄuÞ yt…u÷e ËkÏÞtytu™e Ëhuhtþ rfk{‚ …tAe yt…u Au ?
(A) mean() (B) mode()
(C) median() (D) average()

24. fuÕËe{tk ™e[u™t{tkÚte fÞwk rMxÙk„ Vkfþ™ (rðÄuÞ) yt…u÷e (þtrçŒf ÷¾tÛt) ®MxÙ„™e ÷kƒtE (fux÷t yûth™tu
Ë{tðuþ Au ‚u) sÛttðu Au ?
(A) length() (B) size()
(C) len() (D) yuf …Ût ™nª

25. ™e[u™t{tkÚte fÞtu fuÕËe™tu ‚trfof rðÄuÞ ™Úte ?
(A) proper (B) OR
(B) AND (D) NOT

26. ™e[u™t{tkÚte fÞwk yuf ftÞoher‚ Au su{tk Ë{MÞt™t Wfu÷ {txu Þkºt îtht fhðt{tk ytð‚t Œhuf ftÞo™u
r[ºttí{f MðY…u hsq fhðt{tk ytðu Au ?
(A) Ëwztu ftuz (B) V÷tu [txo
(C) …tE [txo (D) yÕ„turhÄ{

27. ™e[u™t{tkÚte fÞwk r[nT™ ^÷tu [txo{tk yk‚ Œþtoððt {txu ðt…hðt{tk ytðu Au ?
(A) ð‚wo¤ (B) nehtu
(C) „tu¤ ¾qÛttytuðt¤tu ÷kƒ[tuhË (D) [tuhË

28. ^÷tu [txo{tk y™wËkÄt™ r[nT™ Œþtoððt {txu fÞwk r[nT™ ÷¾tÞ Au ?
(A) [tuhË (B) ð‚wo¤
(C) nehtu (D) ÷kƒ[tuhË

29. Ëe ¼t»tt{tk {q¤tûthtu™u fux÷t ð„tuo{tk ðnU[e þftÞ Au ?
(A) 2 (B) 3
(C) 4 (D) 6

“Ët[tu rþûtf yu s ntuÞ Au su rðãtÚteoytu™u ytð™tht …zfthtu {txu ‚iÞth fhu.”
– ztì. Ëðo…Õ÷e htÄtf]»ý™T– ztì. Ëðo…Õ÷e htÄtf]»ý™T– ztì. Ëðo…Õ÷e htÄtf]»ý™T– ztì. Ëðo…Õ÷e htÄtf]»ý™T– ztì. Ëðo…Õ÷e htÄtf]»ý™T
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30. Ëe ¼t»tt{tk ™e[u™t{tkÚte fÞwk y{tLÞ [÷™wk ™t{ Au ?
(A) interest (B) marks100
(C) _file (D) total&value

31. Ëe ¼t»tt{tk Ëtkfur‚f y[÷tu™u ÔÞtÏÞtrÞ‚ fhðt {txu ™e[u™t{tkÚte fE ðtõÞh[™t™tu W…Þtu„ fhðt{tk
ytðu Au ?
(A) #define identifier value (B) #define value identifier
(C) #value identifier definition (D) yuf …Ût ™nª

32. Ëe ¼t»tt{tk ÷¾ðt{tk ytðu÷e VtE÷™wk y™w÷kƒ™ þwk ntuÞ Au ?
(A) .c (B) .ci
(C) .onj (D) .exe

33. ™e[u™t{tkÚte fÞtu Ëe ¼t»tt™tu „trÛtr‚f «r¢Þf ™Úte ?
(y) + (B) %
(C) / (D) \

34. ™e[u™t{tkÚte fÞtu Ëe ¼t»tt™tu ËkƒkÄËq[f «r¢Þf Au ?
(A) == (B) &&
(C) || (D) /

35. þh‚tu™u [ftËðt {txu Ëe ¼t»tt{tk x™ohe «r¢Þf yÚtðt þh‚e «r¢Þf ™e[u™t{tkÚte fE r™þt™eytu™tu
W…Þtu„ fhu Au ?
(A) “?:” (B) “\/”
(C) “#&” (D) “$&”

36. Ëe ¼t»tt{tk ™e[u™t{tkÚte fÞt «r¢Þf r[nT™™tu W…Þtu„ ‚trfof NOT {txu ÚttÞ Au ?
(A) && (B) ||
(C) ! (D) <>

37. Ëe ¼t»tt{tk yt…u÷ zuxt «fth™u W…™t{ yt…ðt {txu ™e[u™t{tkÚte fÞt fe ðzo™tu W…Þtu„ fhðt{tk ytðu Au ?
(A) enum (B) deg
(C) printv (D) typedef

38. Ëe ¼t»tt{tk value++™tu yÚto þwk fhe þftÞ ?
(A) …tuMx RL¢e{uLx (B) …tuMx ze¢e{uLx
(C) r« RL¢e{uLx (D) r« ze¢e{uLx

39. Ëe ¼t»tt{tk «tu„út{™tu y{÷ fh‚e ð¾‚u yuf yûth ðtk[ðt {txu fÞt rðÄuÞ™tu W…Þtu„ ÚttÞ Au ?
(A) gets() (B) getchar()
(C) puts() (D) getl()

40. Ëe ¼t»tt{tk ™e[u™t{tkÚte fÞt rðÄuÞ™tu W…Þtu„ W…Þtu„f‚to îtht xtE… fhðt{tk ytðu÷ yûth™u M¢e™
…h Œþtoððtu ™ ntuÞ íÞthu ÚttÞ Au ?
(A) getchar() (B) getch()
(C) getc() (D) gets()

“òu ÷tuftu {™u yuf Ëtht rþûtf ‚hefu ÞtŒ fhu ‚tu ‚u {tht {txu ËtiÚte {tuxwk ËL{t™ nþu.”
– yu.…e.su.yçŒw÷f÷t{– yu.…e.su.yçŒw÷f÷t{– yu.…e.su.yçŒw÷f÷t{– yu.…e.su.yçŒw÷f÷t{– yu.…e.su.yçŒw÷f÷t{
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41. ™e[u™t{tkÚte fÞt ËtÄ™ îtht «tu„út{{tk E™…wx þfÞ Au ?
(A) feƒtuzo (B) M…efh
(C) r«Lxh (D) {tur™xh

42. Ëe ¼t»tt{tk Vtu{uoxuz E™…wx {txu ™e[u™t{tkÚte fÞt rðÄuÞ™tu W…Þtu„ ÚttÞ Au ?
(A) gets() (B) getc()
(C) getch() (C) scanf()

43. Ëe ¼t»tt {q¤¼q‚ he‚u fux÷t «fth™t r™ÛtoÞ {t¤¾t {txu™t rðÄt™ …qht …tzu Au ?
(A) yuf (B) ƒu
(C) ºtÛt (D) [th

44. Ëe ¼t»tt{tk if rðÄt™™tu W…Þtu„ ™e[u™t{tkÚte fÞt «fthu fhe þftÞ ?
(A) Ëh¤ if rðÄt™ (B) if-else  rðÄt™
(C) else–if rðÄt™ (D) W…h™t ‚{t{

45. Ëe ¼t»tt{tk sÞthu yt…u÷ y™uf …ËkŒ„eytu{tkÚte ftuE yuf r¢Þt …ËkŒ fhðt™e ntuÞ íÞthu fÞt rðÄt™™tu
W…Þtu„ ÚttÞ Au ?
(A) Ëh¤ if rðÄt™ (B) ÷q… rðÄt™
(C) switch rðÄt™ (D) yuf …Ût ™nª

46. ™e[u™t if rðÄt™™t y{÷ ƒtŒ flag [÷™e rfk{‚ fE nþu ?
int flag = 0;
if (5<8)
{flag=1;}
(A) 0 (B) 1
(C) 5 (D) 8

47. ™e[u™t{tkÚte fE Ëe ¼t»tt™e r™„o{ r™ÞkºtÛt ÷q… Au ?
(A) for (B) while
(C) do...while (D) yuf …Ût ™nek

48. Ëe ¼t»tt{tk for ÷q…{tk fÞt «r¢Þf™tu W…Þtu„ fhe™u yufÚte ðÄw «t[÷™tu ythk¼ fhe þftÞ Au ?
(A) . Dot (B) , Coma
(C) : Colon (D) ; Semi Colon

49. Ëe ¼t»tt{tk ßÞthu Vuht™e ËkÏÞt …qðo r™rù‚ ™ ntuÞ y™u ÷q…™u yxftððt {txu™e þh‚ ÷q…{tk «ðuþ
fh‚t …nu÷tk [ftËðt™e ntuÞ íÞthu fE ÷q…™tu W…Þtu„ ðÄw y™wfq¤ Au ?
(A) for (B) while
(C) do ... while (D) yuf …Ût ™nª

50. Ëe ¼t»tt{tk ÷q…™t y{÷ Œhr{Þt™ fux÷ef ðth ÷q…™t yLÞ rðÄt™tu™tu y{÷ fÞto rð™t ÷q…™u y[t™f
s yxftðe Œuðt™e sYh …zu íÞthu fÞt rðÄt™™tu W…Þtu„ ÚttÞ Au ?
(A) break (B) continue
(C) go (D) exit

“…tu‚t™t rðãtÚteoytu fu Atºttu{tk Ëso™tí{f ¼tð y™u ¿tt™™tu yt™kŒ
s„tzu ‚u rþûtf™tu {n¥ð…qýo „wý Au.”    – ytÕƒxo ytELMxtE™   – ytÕƒxo ytELMxtE™   – ytÕƒxo ytELMxtE™   – ytÕƒxo ytELMxtE™   – ytÕƒxo ytELMxtE™
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¢{ {tË «fhý                «fhý™wk ™t{ ykŒtrs‚

™kƒh ‚tË

1. sq™ 1. fB…tuÍh™tu W…Þtu„ fhe HTML Vtu{o™e h[™t 05

2. fuMfu®z„ MxtR÷þex y™u òðtrM¢Ãx (y…qýo) 06

2. sw÷tE 2. fuMfu®z„ MxtR÷þex y™u òðtrM¢Ãx (…qýo) 06

3. fB…tuÍh™tu W…Þtu„ fhe Ëh¤ ðuƒËtEx™e h[™t 08

4. E-ftu{Ëo™tu …rh[Þ 06

3. ytì„Mx 5. yu{-ftu{Ëo™tu …rh[Þ 08

6. ytìçsuõx ytÄtrh‚ ÏÞt÷tu 06

4. ËÃxuBƒh 7. òðt™e {q¤¼q‚ ƒtƒ‚tu (y…qýo) 10

5. ytìõxtuƒh 7. òðt™e {q¤¼q‚ ƒtƒ‚tu (…qýo) 05

6. ™ðuBƒh 8. òðt{tk õ÷tË y™u ytìçsuõx (y…qýo) 12

7. rzËuBƒh 8. òðt{tk õ÷tË y™u ytìçsuõx (…qýo) 02

9. yìhu y™u ®MxÙ„™tu W…Þtu„ 11

8. òLÞwythe 13. yLÞ W…Þtu„e r™:þwÕf xwÕË y™u Ëuðtytu 05

9. Vuƒúwythe – …w™htð‚o™ –

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-12
rð»tÞ : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f (331)  y™u «tÞtur„f (332))

yÇÞtË¢{™wk {tËðth ytÞtus™

™tUÄ : «fhý 13 {tkÚte ™e[u™t 3 {wÆt Ëk…qýo hŒ fhu÷ Au.
(1) ‘yth’ Ëtu^xðuh (…us ™kƒh 267)
(2) ‘yth’{tk yt÷u¾ Œtuhðt. (…us ™kƒh 269)
(3) huþ™÷ Ã÷t™ (…us ™kƒh 271)

“su Äehs ™ „w{tðu, rðãtÚteo™t Mð¼tð™e r™Œtuo»t‚t{tk y™u ‚u™t
ÓŒÞ™t ËtisLÞ{tk y¾kz rðïtË ht¾e þfu ‚u s Ët[tu rþûtf.” – ‘y™t{e’– ‘y™t{e’– ‘y™t{e’– ‘y™t{e’– ‘y™t{e’
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™tUÄ : ËiØtkr‚f «&™…ºt …Ør‚ ytÄtrh‚ hnuþu.

nu‚wytu ¿tt™ (K) Ë{s (U) W…Þtus™ (A) ftiþÕÞ (S) fw÷ „wý
„wý 30 30 30 10 100

xft(%) 30% 30% 30% 10% 100%

frX™‚t{qÕÞ …h™tu „wý¼th

¢{tkf  frX™‚t™wk M‚h frX™‚t{qÕÞ „wý¼th «&™tu™wk MðY… nu‚w÷ûte (MCQ)
1. Ëh¤ 50% 50 «&™tu™e ËkÏÞt 100

2. {æÞ{ 35% 35 Vt¤ðu÷ „wý 100

3. frX™ 15% 15 ykŒtrs‚ Ë{Þ 2 f÷tf
         fw÷ 100% 100

«fhý y™wËth „wý¼th™e Vt¤ðýe

¢{ «fhý ¢{ «fhý™wk ™t{ ËiØtkr‚f „wý¼th «tÞtur„f „wý¼th

1. 1 fB…tuÍh™tu W…Þtu„ fhe HTML Vtu{o™e 10 7
h[™t fhðe

2. 2 fuMfu®z„ MxtE÷þex y™u òðtrM¢Ãx 12 8

3. 3 fB…tuÍh™tu W…Þtu„ fhe Ëh¤ ðuƒËtRx™e h[™t 10 10

4. 4 E-ftu{Ëo™tu …rh[Þ 10 0

5. 5 yu{-ftu{Ëo™tu …rh[Þ 12 0

6. 6 ytìçsuõx ytÄtrh‚ ÏÞt÷tu 10 0

7. 7 òðt™e {q¤¼q‚ ƒtƒ‚tu 10 10

8. 8 òðt{tk õ÷tË y™u ytìçsuõx 10
15

9. 9 yìhu y™u ®MxÙ„™tu W…Þtu„ 10

10. 13 yLÞ W…Þtu„e r™:þwÕf xwÕË y™u Ëuðtytu 06 0

                          fw÷ 100 50

“rþûtf fŒe þe¾‚tu ™ hnu ‚tu yu fŒe þe¾ðe ™ þfu.” ––––– hðeLÿ™tÚt xt„tuhhðeLÿ™tÚt xt„tuhhðeLÿ™tÚt xt„tuhhðeLÿ™tÚt xt„tuhhðeLÿ™tÚt xt„tuh

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-12  (rð¿tt™ y™u Ët{tLÞ «ðtn)
rð»tÞ : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f (331) y™u «tÞtur„f (332))

ðtŠ»tf …heûtt
Ë{Þ : 2 f÷tf «&™…ºt™kw …rhY… „wÛt : 100
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1. HTML{tk Vtu{o™e h[™t fhðt {txu ™e[u™t{tkÚte fÞt ½xf™tu W…Þtu„ fhðt{tk ytðu Au ?
(A) <form> (B) <action>

(C) <image> (D) <text>

2. HTML Vtu{o{tk rVÕz™u …qðo r™Ätorh‚ ®f{‚ ËtÚtu Œþtoððt {txu fE ÷tûtrýf‚t™tu W…Þtu„ fhðt{tk
ytðu Au ?
(A) text (B) value

(C) name (D) type

3. HTML Vtu{o{tk rVÕz™u ™t{ yt…ðt {txu (input) ½xf™e fE ÷tûtrýf‚t™tu W…Þtu„ fhðt{tk
ytðu Au ?
(A) name (B) type

(C) value (D) initial

4. fB…tuÍh{tk swŒt swŒt xw÷ƒth y™u MxuxË ƒth Œþtoððt {txu ™e[u™t{tkÚte fÞt {u™w rðfÕ…™tu W…Þtu„
ÚttÞ Au ?
(A) Edit → Show (B) Format → Show

(C) View → Show (D) Insert → Show

5. fB…tuÍh{tk ËtRx {u™ush™t rð¼t„™u ƒkÄ fhðt {txu ™e[u™t{tkÚte fE ‘fe’™tu W…Þtu„ ÚttÞ Au ?
(A) F3 (B) F5

(C) F6 (D) F9

6. fB…tuÍh™t Vtu{o{tk [ufƒtufË ƒ™tððt {txu ™e[u™t{tkÚte fÞt {u™w rðfÕ…™tu W…Þtu„ ÚttÞ Au ?
(A) Form → Form Field (B) File → Form Field

(C) Format → Form Field (D) Tools → Form Field

7. fB…tuÍh™t Vtu{o{tk hurzÞtu ƒx™™tu ftuE rðfÕ…™u …qðo r™Ätorh‚ he‚u …ËkŒ fhu÷tu ht¾ðt RåA‚t
ntuEyu ‚tu ™e[u™t{tkÚte fÞt ÷¾tÛt yt„¤ ytðu÷wk [ufƒtufË …ËkŒ fhðwk òuEyu ?
(A) Initially selected (B) Initially checked

(C) Selected (D) yuf …Ût ™nª

“rþûtf {t™ðð‚o™™tu Es™uh Au.” – ztì. {Äwheƒu™ þtn– ztì. {Äwheƒu™ þtn– ztì. {Äwheƒu™ þtn– ztì. {Äwheƒu™ þtn– ztì. {Äwheƒu™ þtn

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-12 (rð¿tt™ y™u Ët{tLÞ «ðtn)
rð»tÞ : fBÃÞqxh yæÞÞ™ (ËiØtkr‚f) (331)

ðtŠ»tf …heûtt
Ë{Þ : 2 f÷tf ™{q™t™wk «&™…ºt „wÛt : 100
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8. HTML{tk Vtu{o™e rð„‚tu {tuf÷‚e ð¾‚u HTTP …jr‚ M…ü fhðt {txu ™e[u™t{tkÚte Vtu{o™e fE
÷tûtrÛtf‚t™tu W…Þtu„ fhðt{tk ytðu Au ?
(A) submit (B) action

(C) method (D) input

9. HTML Vtu{o{tk ™e[u™t{tkÚte fE …jr‚ yuf Ë{Þu {tºt {ÞtorŒ‚ {trn‚e {tuf÷ðt™e y™w{r‚ …qhe
…tzu Au ?
(A) GET (B) POST

(C) SET (D) PVT

10. ™e[u™t{tkÚte fÞwk r™:þwÕf ytu…™ ËtuËo ðuƒ rðftË {txu™wk IDE Au ?
(A) HTML (B) KompoZer

(C) SciTE (D) Base

11. ™e[u™t{tkÚte ftu™tu W…Þtu„ ðuƒËtEx{tk Œþo™eÞ Îtxftu {txu™e þi÷e M…ü fhðt {txu ÚttÞ Au ?
(A) Cascading Style Sheet (B) Webpage

(C) Form (D) Animation

12. CSS Rules™t {wÏÞ fux÷t rð¼t„tu Au ?
(A) ƒu (B) ºtý
(C) [th (C) A

13. fB…tuÍh{tk Cascade ƒx™ ™e[u™t{tkÚte fÞt xq÷ ƒth …h W…÷çÄ Au?
(A) Format Toolbar1 (B) Format Toolbar2

(C) Composition Toolbar (D) Editmode Toolbar

14. CSS Style sheet ztÞ÷tu„ ƒtufË{tk fÞt rð¼t„{tk r™{toÛt fhðt{tk ytðu÷ CSS ftuz
Œþtoððt{tk ytðu Au ?
(A) General (B) Text

(C) Lists (D) Aural

15. ™e[u™t{tkÚte fE ËkMÚttyu òðt rM¢Ãx™tu rðftË fÞtuo ?
(A) Yahoo (B) Google

(C) Wikipedia (D) Netscape

16. ™e[u™t{tkÚte fE r™þt™e îtht òðt rM¢Ãx ç÷tuf™e þYyt‚ y™u yk‚ Œþtoððt{tk ytðu Au ?
(A) yÄorðht{ (semi colon) (B) [tuhË ftIË (square bracket)
(C) A„rzÞtu ftIË (curly bracket) (D) ËtŒt ftIË (round bracket)

17. òðt rM¢Ãx{tk ™e[u™t{tkÚte fÞt rðÄt™™tu W…Þtu„ rðÄuÞ{tk rfk{‚ …h‚ fhðt {txu ÚttÞ Au ?
(A) return (B) function

(C) select (D) send

“su htßÞ{tk W¥t{ rþûtftu ðÄw ‚u htßÞ{tk su÷ ytuAe nþu.” – Ã÷uxtu– Ã÷uxtu– Ã÷uxtu– Ã÷uxtu– Ã÷uxtu
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18. rð„‚tu™tu Ëk„ún fhðt {txu™t Ëk„útnf™u þwk fnu Au ?
(A) [÷ (B) …qýtOf
(C) ½x™t (D) ½x™t-Ëk[t÷f

19. òðt rM¢Ãx{tk W…Þtu„f‚to Vtu{o™wk rVÕz …ËkŒ fhu íÞthu fE Îtx™t WŒT¼ðu Au ?
(A) focus (B) load
(C) select (D) click

20. ƒútWÍh ytìçsuõx {tuzu÷{tk ™e[u™t{tkÚte fÞt ytìçsuõx™e …jr‚ytu y™u „wÛtÄ{tuo îtht ðuƒ ƒútWÍh™e
rðLztu™u r™ÞkºtÛt fhðt{tk ytðu Au ?
(A) window (B) document
(C) history (D) location

21. òðt rM¢Ãx{tk r™rù‚ ftÞo™u …th …tz‚t …w™: W…Þtu„{tk ÷E þftÞ ‚uðt ftuz™t ç÷tuf™u þwk fnu Au ?
(A) rðÄuÞ (B) [÷
(C) yìhu (D) ½x™t

22. ™e[u™t{tkÚte fE M¢eÃxª„ ¼t»tt™tu W…Þtu„ ðuƒ …us{tk «tu„útr{k„ W{uhðt {txu fhðt{tk ytðu Au ?
(A) Action script (B) Java Script
(C) HTML (D) CSS

23. rðrþü nu‚w {txu …hM…h òuztÞu÷t ðuƒ …us™t Ë{qn™u þwk fnu Au ?
(A) Vtu{o (B) ðuƒËtEx
(C) CSS (D) ztufÞw{uLx

24. ðuƒËtEx{tk fuðe {trn‚e ntuðe òuEyu ?
(A) Ëk…qÛto, ËkƒkrÄ‚ (B) Ëk…qÛto, yËkƒkrÄ‚
(C) y…qÛto, yËkƒkrÄ‚ (D) y…qÛto, ËkƒkrÄ‚

25. ðuƒËtEx™e rðftË «r¢Þt{tk ™e[u™t{tkÚte fÞtu {wÆtu y„íÞ™tu ™Úte ?
(A) nu‚w (B) «uûtf„Ût
(C) rð»tÞðM‚w (D) r™ðuþ

26. ðuƒ …us™wk þe»tof ðuƒ ƒútWÍh{tk fÞtk Œþtoððt{tk ytðu Au ?
(A) MxuxË ƒth{tk (B) xtEx÷ ƒth{tk
(C) {u™w ƒth{tk (D)  xq÷ ƒth{tk

27. fB…tuÍh{tk ðuƒ …us{tk xuƒ÷ W{uhðt {txu fÞt {u™w rðfÕ…™tu W…Þtu„ ÚttÞ Au ?
(A) Insert → Table (B) Format → Table
(C) Edit → Table (D) View → Table

28. ðuƒËtEx™u ðuƒ Ëðoh …h y…÷tuz fhðt™e søÞt ™e[u™t{tkÚte ftuÛt …qhe …tzu Au ?
(A) Internet Service Provider (B) Internet Host Provider
(C) Internet Space Provider (D) Internet Space Manager

“{thtu sL{ {tht {t‚t-r…‚t™u yt¼the Au, …hk‚w {thwk Sð™ ‚tu {tht rþûtf™u s yt¼the Au.”
– yì÷ufÍtLzh– yì÷ufÍtLzh– yì÷ufÍtLzh– yì÷ufÍtLzh– yì÷ufÍtLzh
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29. fBÃÞqxh …hÚte ðuƒ ntuMx …h VtE÷tu™t MÚtt™tk‚hÛt {txu ™e[u™t{tkÚte þu™tu W…Þtu„ ÚttÞ Au ?
(A) FTP (B) HTP

(C) STP (D) NST

30. fB…tuÍh{tk r÷kf™e h[™t fhðt {txu fÞt {u™w rðfÕ…™tu W…Þtu„ ÚttÞ Au ?
(A) Insert --> Link (B) Format --> Link

(C) Edit --> Link (D) View --> Link

31. ™e[u™t{tkÚte fÞwk ytu…™ ËtuËo WYSIWYG «fth™wk HTML yìrzxh Au fu su yk„úuS, s{o™, z[
y™u [tE™eÍ suðe ¼t»tt™wk Ë{Úto™ fhu Au ?
(A) yÃxt™t MxwrzÞtu (B) ç÷qr„úVtu™
(C) y{tÞt (D) fB…tuÍh

32. ytu…™ ËtuËo WYSIWYG «fth™wk ðuƒ yìrzxh y{tÞt ftu™t îtht rðfrË‚ fhðt{tk ytÔÞwk Au ?
(A) W3C (B) WWW

(C) NetScape (D) Windows

33. RLxh™ux suðt R÷ufxÙtur™f {tæÞ{™tu W…Þtu„ fhe Wí…tŒ™™wk ¾heŒ-ðu[tÛt Ëuðt y™u {trn‚e …qhe
…tzðt™t ftÞo™u þwk fnu Au ?
(A) E-ftu{Ëo (B) …hk…ht„‚ ftu{Ëo
(C) yu÷-ftu{Ëo (D) ðirïf ftu{Ëo

34. ™e[u™t{tkÚte …wM‚ftu™e ytì™÷tR™ Œwft™™wk WŒtnhÛt fÞwk Au ?
(A) amazon (B) irctc

(C) gmail (D) yahoo

35. RLxh™ux …h rzrsx÷ MðY…u W…÷çÄ ð‚o{t™…ºt™u þwk fnu Au ?
(A) I-Newspaper (B) Internet Newspaper

(C) www-Newspaper (D) E-Newspaper

36. ™e[u™t{tkÚte fE ytì™÷tR™ nhtS {txu™e «[r÷‚ ðuƒËtEx Au ?
(A) www.amazon.com (B) www.myntra.com

(C) www.makemytrip.com (D) www.ebay.com

37. ¼th‚eÞ hu÷ðu™e ðuƒËtEx …h rxrfx™e ™tukÄÛte ÚtE „Þt ƒtŒ „útnf™u ™e[u™t{tkÚte fE he‚u
{tuf÷ðt{tk ytðu Au ?
(A) E-{uE÷ îtht (B) SMS îtht
(C) (A) y™u (B) ƒk™u (D) yuf …Ût ™nª

38. ™e[u™t{tkÚte fE {tfuo®x„ y™u ðu[tÛt {txu™e «[r÷‚ ðuƒËtEx ™Úte ?
(A) www.homeshop18.com (B) www.flipkart.com

(C) www.pnbindia.in (D) www.myntra.com

“rþûtf™wk Sð™ ¾wÕ÷e rf‚tƒ suðwk ntuðwk òuEyu. rþûtf™wk rƒ™Œk¼e y™u
r™»f÷kf Sð™ s ƒt¤ftu {txu «uhýtËútu‚ ƒ™e hnu Au.” – {ntí{t „tkÄeS– {ntí{t „tkÄeS– {ntí{t „tkÄeS– {ntí{t „tkÄeS– {ntí{t „tkÄeS
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39. RLxh™ux …h fhðt{tk ytð‚t ƒukf™t ÔÞðnthtu™u ™e[u™t{tkÚte fE «r¢Þt ‚hefu ytu¤¾ðt{tk ytðu Au ?
(A) nhtS (B) ƒtu÷e
(C) ™ux ƒìrLfk„ (D) www.ƒì®Lf„

40. ™e[u™t{tkÚte fÞtu E-ftu{Ëo™tu VtÞŒtu Au ?
(A) Íz… (B) Ëwhûtt
(C) „tu…™eÞ‚t (D) «thkr¼f ¾[o

41. Wí…tŒ™ fu Ëuðt …qhe …tz‚t ÔÞtðËtrÞftu fu ËkMÚttytu RLxh™ux™e ðuƒËtEx …h fE ÔÞðËtÞe «r‚f]r‚™tu
W…Þtu„ fhu Au ?
(A) ÔÞðËtÞeÚte „útnf (B) ÔÞðËtÞeÚte ÔÞðËtÞe
(C) „útnfÚte ÔÞðËtÞe (D) ËhfthÚte ÔÞðËtÞe

42. ËhfthÚte ™t„rhf (G2C) ÔÞðËtÞe «r‚f]r‚™t WÆu~Þ™e …qr‚o {txu „wsht‚ Ëhfthu …tu‚t™wk fÞwk ™uxðfo
rðfrË‚ fÞwO Au ?
(A) GSNET (B) GSWAN

(C) GSLAN (D) GSMAN

43. yu{-ftu{Ëo{tk ™e[u™t{tkÚte fÞt ËtÄ™™tu W…Þtu„ ÚttÞ Au ?
(A) {tuƒtE÷ Vtu™ (B) M{txo Vtu™
(C) …Ëo™÷ rzrsx÷ ytrËMxLx (D) W…h™t ‚{t{

44. ™e[u™t{tkÚte fE yu{-ftu{Ëo™e {ÞtoŒt Au ?
(A) ðirïf Ëk…fo þõÞ ƒ™u Au.
(B) ÔÞðnth ¾[o{tk Îtxtztu ÚttÞ Au.
(C) ÔÞðËtÞ r™hk‚h yux÷u fu 24 X 7 Ë{Þu [÷tðe þftÞ Au.
(D) ‚u {ÞtorŒ‚ ƒuLz rðzÚt („r‚) Ähtðu Au.

45. ÔÞtðËtrÞf nu‚w {txu MÚtt™™e {trn‚e …qhe …tz‚e ‚fTr™f™t W…Þtu„™u þwk fnu Au ?
(A) E-ftu{Ëo (B) yu{-ftu{Ëo
(C) yu÷-ftu{Ëo (D) …hk…ht„‚ ftu{Ëo

46. yu{-ftu{Ëo{tk MÚtt™ ytÄtrh‚ Ëuðt™tk WŒtnhÛt{tk ™e[u™t{tkÚte fE Ëuðt yuf MÚt¤Úte yLÞ MÚt¤ ËwÄe™wk
rŒþtËq[™ fhu Au ?
(A) ™fþt (B) ™urð„uþ™
(C) y™wËkÄt™ Ëuðt (D) {trn‚e yÚtðt r™Œuoþ™ Ëuðtytu

47. ËkMÚtt™t ™uxðfo y™u ƒnth™e Œwr™Þt ðå[u Ët{tLÞ he‚u W…Þtu„{tk ÷uðt‚e ™uxðfo™e Ëwhûtt Ëe{t™u þwk
fnu Au ?
(A) yìrLxðtÞhË Ëtû xðuh (B) rËõÞtuh Ëtufux ÷uÞh
(C) VtÞh ðtu÷ (D) Ëtkfur‚fhÛt

ËV¤ y™u ©uc rþûtf Ë‚‚ ò„]‚, ™ðwk ™ðwk þe¾‚tu,
™ðt yr¼„{tu Mðefth‚tu y™u ƒt¤ftu™u ™ðwk ™ðwk …ehË‚tu ntuÞ Au.” – r«. ¼tu„e¼tE þtn– r«. ¼tu„e¼tE þtn– r«. ¼tu„e¼tE þtn– r«. ¼tu„e¼tE þtn– r«. ¼tu„e¼tE þtn
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48. ™e[u™t{tkÚte þu™t îtht [qfðÛte fh‚e ð¾‚u „útnfu ¢urzx fu zurƒx ftzo ™kƒh …qhtu …tzðtu sYhe ™Úte ?
(A) [tso ftzo (B) M{txo ftzo
(C) E-ðtu÷ux (D) yuf …Ût ™nª

49. ™e[u™t{tkÚte fE ™uþ™÷ …u{uLx ftu…tuohuþ™ ytìV RrLzÞt (NPCI) yu þY fhu÷e ftzo îtht [qfðÛte™e
yuf ™ðe …jr‚ Au ?
(A) E - pay (B) Smart pay
(C) RuPay (D) ePay

50. E-ftu{Ëo y™u yu{-ftu{Ëo Ëwhûtt™tu ™e[u™t{tkÚte fÞtu «fth ¾t‚he yt…u Au fu ËkŒuþ {tuf÷™th ËkŒuþ
{tuf÷ðt™tu R™fth fhe þfþu ™nª ?
(A) yrÄf]‚‚t (B) „wÃ‚‚t
(C) yMðefth (D) y¾krz‚‚t

51. ðtÞhË, ðtu{o y™u xÙtus™ntuËo suðt Œqr»t‚ ftuz™u þtuÄe yxftðe y™u Œqh fhðt™e «r¢Þt fh‚t fBÃÞqxh
«tu„út{™u þwk fnu Au ?
(A) yìrLxðtÞhË Ëtû xðuh (B) rzrsx÷ ËrxorVfux
(C) VtÞh ðtu÷ (D) ¢e…xtu„útVe

52. SSL «tuxtuftu÷™e h[™t ftuÛtu fhe ?
(A) Google (B) Netscape
(C) Yahoo (D) Firefox

53. VtE÷™e ftu…ehtRx {trn‚e™u ytu¤¾ðt {txu r[ºt, ytìrzÞtu fu rðzeÞtu W{uhðt{tk ytð‚t rzrsx÷ ftuz™u
þwk fnu Au ?
(A) Image mark (B) Digital mark

(C) Code mark (D) Water mark
54. ™e[u™t{tkÚte [qfðÛte™t fÞt ftzo™e Ë…txe …h {tE¢tu[e… szu÷e ntuÞ Au ?

(A) M{txo ftzo (B) zurƒx ftzo
(C) ¢urzx ftzo (D) [tso ftzo

55. «tu„útr{k„™e he‚™u fux÷t «fth{tk ðnuk[e þftÞ Au ?
(A) ƒu (B) ºtÛt
(C) [th (D) A

56. ™e[u™t{tkÚte fE «tu„útr{k„ ¼t»tt ytìçsufx ytÄtrh‚ «tu„útr{k„™u Ë{Úto™ yt…‚e ™Úte ?
(A) C (B) Java

(C) PHP (D) VB.net
57. ytìçsufx ytÄtrh‚ …jr‚{tk fE ðM‚w fuLÿrƒkŒw W…h ntuÞ Au ?

(A) zuxt (B) rðÄuÞ
(C) ytìçsufx (D) W…h™t ‚{t{

“W¥t{ rþûtf rðãtÚteo™t rðfË‚t, ¾e÷‚t ÔÞÂõ‚íð™u y™t„ún y™u
rƒ™þh‚e nqkV yt…e™u {n¥ð yt…u Au.”    – {q¤þkfh {tu. ¼è



ËÃxuBƒh, 2025 21

{tæÞr{f

rþûtý

…heûtý

y™u

58. õ÷tË-ztÞt„út{{tk ftuE…Ût f÷tË™u hsq fhðt {txu™t ytRftu™{tk ™e[u™t{tkÚte þu™tu Ë{tðuþ Út‚tu ™Úte ?
(A) name (B) attribute
(C) behaviour (D) procedure

59. õ÷tË  ztÞt„út{{tk …ufus á~Þ‚t {txu fÞt Ëkfu‚™tu W…Þtu„ fhðt{tk ytðu Au ?
(A) – (B) #
(C) + (D) ~

60. ytuçsuõx ytÄtrh‚ ÏÞt÷{tk ™e[u™t{tkÚte ftuÛt «r¢Þt™t y{÷efhÛt™e {trn‚e „wÃ‚ ht¾e™u zuxt™e hsqyt‚
ðzu zuxt™u Ëwhrût‚ ƒ™tðu Au ?
(A) RLfuÃËw÷uþ™ (B) yuƒMxuõþ™
(C) …tu÷e{tuhVeÍ{ (D) yu„úe„uþ™

61. fux÷t «fth™t ytuðh÷turzk„ ðzu …tu÷e{tuhrVÍ{ þõÞ ƒ™u Au ?
(A) ƒu (B) ºtÛt
(C) yuf (D) [th

62. ytuçsufx ytÄtrh‚ ÏÞt÷{tk yu„úe„uþ™ ƒu f÷tË ðå[u™t fuðt ËkƒkÄ™u hsq fhu Au ?
(A) r¼L™ (non exclusive) (B) yòuz (exclusive)
(C) yuftfe (unique) (D) yuf …Ût ™nª

63. õ÷tË-ztÞt„út{{tk yu„úe„uþ™™u fÞt r[nT™ ðzu Œþtoððt{tk ytðu Au ?
(A) ¾t÷e neht™t r[nT™ (B) ¼hu÷t neht™t r[nT™
(C) ¾t÷e [tuhË™t r[nT™ (D) ¼hu÷t [tuhË™t r[nT™

64. R™nuhexLË Ët{tLÞ he‚u ƒu f÷tË ðå[u fuðt «fth™tu ËkƒkÄ sÛttðu Au ?
(A) is-a-kind-of (B) has-a-kind-of
(C) a-part-of (D) yuf …Ût ™nª

65. ytuçsufx ytÄtrh‚ «tu„útr{k„ ¼t»tt òðt ™e[u™t{tkÚte ftu™t îtht rðfËtððt{tk ytðe Au ?
(A) Microsoft (B) NetScape
(C) Sun Microsystem (D) W3C

66. òðt ðåÞwoy÷ {þe™™e Þtkrºtf ¼t»tt™u þwk fnuðt{tk ytðu Au ?
(A) Source code (ËtuËo ftuz) (B) Byte code (ƒtEx ftuz)
(C) Binary code (ƒtÞ™he ftuz) (D) yuf …Ût ™nª

67. òðt ËtuËo «tu„út{ VtE÷™wk y™w÷kƒ™ þwk ntuðwk òuEyu ?
(A) .int (B) .java
(C) .html (D) .exe

68. òðt{tk ™e[u™t{tkÚte fÞt «tÚtr{f zuxt «fth{tk y…qýtOf ËkÏÞt™tu Ë{tðuþ fhe þftÞ Au ?
(A) byte (B) short
(C) int (D) double

“su …wM‚f{tkÚte þe¾e þft‚wk ™Úte ‚u rþûtf™t Sð™ îtht þe¾e þftÞ Au.” – Mðt{e ËÂå[Œt™kŒ– Mðt{e ËÂå[Œt™kŒ– Mðt{e ËÂå[Œt™kŒ– Mðt{e ËÂå[Œt™kŒ– Mðt{e ËÂå[Œt™kŒ
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69. òðt{tk xuƒ {txu ™e[u™t{tkÚte fÞt yuMfu… ftuz™tu W…Þtu„ ÚttÞ Au ?
(A) /n (B) /t
(C) /b (D) /r

70. òðt{tk yuf-÷exe™e ftu{uLx {txu ™e[u™t{tkÚte ftu™tu W…Þtu„ ÚttÞ Au ?
(A) // (B) /* .... */
(C) /** .... */ (D) yuf …Ût ™nª

71. ™e[u™t{tkÚte fÞtu òðt™tu ‚w÷™tí{f «r¢Þf ™Úte ?
(A) == (B) !=
(C) < (D) <>

72. òðt{tk ßÞthu [÷ fu …Œtðr÷™e rfk{‚ «{tÛtu y÷„ y÷„ ÎtÛttk ftÞtuo™t rðfÕ… ntuÞ íÞthu ™e[u™t{tkÚte
þu™tu W…Þtu„ fhðt{tk ytðu Au ?
(A) Mðe[ Mxux{uLx (B) for ÷q…
(C) while ÷q… (D) do... while ÷q…

73. òðt{tk fÞt rðÄt™™tu W…Þtu„ rMð[ fu ÷q… «fth™e h[™t™e ƒnth «tu„út{™wk r™ÞkºtÛt Vuhððt {txu ÚttÞ
Au ?
(A) continue (B) gets
(C) break (D) exit

74. òðt{tk ™e[u™t{tkÚte þu™tu W…Þtu„ RL¢e{uLx «r¢Þf ‚hefu fhðt{tk ytðu Au ?
(A) ++ (B) - -
(C) ** (D) //

75. òðt{tk f÷tË™u ÔÞtÏÞtrÞ‚ fhðt {txu fÞt [tðeY… þçŒ™tu W…Þtu„ fhðt{tk ytðu Au ?
(A) Class (B) class
(C) CLASS (D) W…h™t ‚{t{

76. òðt{tk ™e[u™t{tkÚte þu™tu ytuçsufx ƒ™tððt {txu™t …„÷tk™tu Ë{tðuþ Út‚tu ™Úte ?
(A) Declaration (B) Instrantiation
(C) Initialization (D) yuf …Ût ™nª

77. òðt{tk ytuçsuõx™tu Ëk„ún {u{he™t su ¾tË ¼t„{tk fhðt{tk ytðu Au, ‚u™u þwk fnu Au ?
(A) ROM (B) Heap
(C) HD (D) CD

78. òðt{tk ™e[u™t{tkÚte fÞt ðuheyuƒ÷ ([÷) {uÚtz fu ç÷tuf™e ykŒh ÔÞtÏÞtrÞ‚ fhu÷t ntuÞ Au ?
(A) ÷tuf÷ (B) RLMxLË
(C) õ÷tË (D) yuf …Ût ™nª

79. òðt{tk ™e[u™t{tkÚte fÞt rðÍeƒe÷exe {tuzeVtÞh™e {ŒŒÚte ËtiÚte Wå[ fûtt™wk «tuxufþ™ {u¤ðe
þftÞ Au ?
(A) …rç÷f (B) …ufus
(C) «tuxuõxuz (D) «tRðux

“rþûtf yfoðt¤tu, ‚foðt¤tu, {Äw…foðt¤tu y™u Ë‚‚ Ëk…foðt¤tu ntuðtu òuEyu.” – …q. {tuhtrhƒt…w– …q. {tuhtrhƒt…w– …q. {tuhtrhƒt…w– …q. {tuhtrhƒt…w– …q. {tuhtrhƒt…w
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80. òðt{tk Ëƒ f÷tË ƒ™tððt {txu f÷tË™e ÔÞtÏÞt{tk fÞt [tðeY… þçŒ™tu W…Þtu„ ÚttÞ Au ?
(A) derive (B) extends
(C) super (D) yuf …Ût ™nª

81. Ëw…h õ÷tË™t fLMxÙfxh™u ftu÷ fhðt {txu Ëƒ õ÷tË™t fLMxÙõxh{tk fÞt [tðeY… þçŒ™tu W…Þtu„
ÚttÞ Au ?
(A) derive (B) super
(C) main (D) W…h™t ‚{t{

82. òðt{tk fB…turÍþ™ y™u yu„úe„uþ™ y÷„ y÷„ f÷tË ðå[u fuðt «fth™tu ËkƒkÄ h[u Au ?
(A) is-a (B) has-a
(C) a-part (D) yuf …Ût ™nª

83. òðt{tk ™e[u™t{tkÚte fÞtu «r¢Þf ytuçsufx ƒ™tðu Au y™u ‚u™tu huVhLË …h‚ fhu Au ?
(A) ztux (.) (B) new
(C) ftu÷tu™ (:) (D) yuËtR™{uLx (=)

84. ™e[u™t{tkÚte fE {uÚtz ytuçsufx ƒ™tð‚t Ë{Þu yt…tuyt… RLðtuf ÚttÞ Au ?
(A) RLMxLË {uÚtz (B) fLMxÙfxh
(C) f÷tË {uÚtz (D) W…h™t ‚{t{

85. òðt{tk ™e[u™t{tkÚte fÞtu yuf s «fth™t Îtxftu™t Ëk„ún™u hsq fh‚tu [÷ Au ?
(A) yìhu (B) {uÚtz
(C) õ÷tË (D) yuf …Ût ™nª

86. java.util.Arrays õ÷tË™e ™e[u™t{tkÚte fE {uÚtz™tu W…Þtu„ Ë{„ú yìhu fu ‚u™t y{wf ¼t„™u ¢{t™wËth
„tuXððt {txu ÚttÞ Au ?
(A) sort() (B) fill()
(C) arrang() (D) order()

87. nth y™u M‚k¼ MðY…u ftuüfeÞ {trn‚e™t Ëk„ún {txu ™e[u™t{tkÚte fÞt yìhu™tu W…Þtu„ ÚttÞ Au ?
(A) yuf–…rh{tÛteÞ (B) rî–…rh{tÛteÞ
(C) ƒnw–…rh{tÛteÞ (D) yuf …Ût ™nª

88. òðt{tk ™e[u™t{tkÚte fÞtu fLMxÙfxh yuf …Ût yûth ð„h™tu rMxÙk„ ytìçsufx ƒ™tðu Au ?
(A) String() (B) String (string literals)
(C) String (string strobj) (D) String (char ary[ ])

89. òðt{tk ™e[u™t{tkÚte fÞt ftÞtuo fhðt {txu ®MxÙ„ f÷tË {ìÚtz …qhe …tzu Au ?
(A) ƒu ®MxÙ„™e ‚w÷™t fhðe (B) ®MxÙ„™e ÷kƒtE {u¤ððe
(C) ®MxÙ„™wk rð¼ts™ fhðwk (D) W…h™t ‚{t{

90. òðt{tk compareTo(string str) {ìÚtz ™e[u™t{tkÚte fE ®f{‚ …h‚ fhþu, òu {ìÚtz ftu÷ fh™th ®MxÙ„
ytìçsufx «t[÷ str™e ‚w÷™t yu {tuxe ntuÞ ?
(A) 0 (B) >0
(C) <0 (D) yuf …Ût ™nª

“þe÷ðt™ ËtÄw ntuÞ, «¿ttðt™ ¿tt™e ntuÞ, fhwýtðt™ {t‚t ntuÞ.
          …hk‚w rþûtf ‚tu ËtÄw, ¿tt™e y™u {t‚t-ºtýuÞ ntuÞ Au.”  - rð™tuƒt ¼tðu



24 ËÃxuBƒh, 2025

{tæÞr{f

rþûtý

…heûtý

y™u

91. òðt{tk ®MxÙ„ õ÷tË™e ™e[u™t{tkÚte fE {ìÚtz, {ìÚtz ftu÷ fh‚e ®MxÙ„ ytìçsuõx{tk hnu÷t yûthtu™e ËkÏÞt
…h‚ fhu Au ?
(A) int length() (B) int size()
(C) int long() (D) int count()

92. òðt{tk Date õ÷tË™e ™e[u™t{tkÚte fE {ìÚtz Date ytìçsufx™t ‚the¾ y™u Ë{Þ™u rMxÙk„{tk hsq fhe
‚u rMxÙk„ …h‚ fhu Au ?
(A) StringtoDate() (B) DatetoString()
(C) StringtoString() (D) DateTimetoString()

93. òðt{tk ™e[u™t{tkÚte þwk yìhu™e «thkr¼f RLzufË rfk{‚™tu WÕ÷u¾ fhu Au ?
(A) 0 (B) 1
(C) null (D) W…h™t ‚{t{

94. òðt{tk òu yt…Ûtu Calendar õ÷tË™e get {ìÚtz{tk DAY-OF-WEEK «t[÷ ‚hefu ðt…heyu ‚tu
fÞt «fth™e rfk{‚ …h‚ Útþu ?
(A) int (B) char
(C) string (D) boolean

95. fBÃÞqxh VtE÷ y™u rzhufxhe {txu™e Ëk„únMÚtt™™e sYrhÞt‚tu Îtxtzðt {txu™e ‚fTr™ftu™u þwk fnuðt{tk
ytðu Au ?
(A) zuxt Ëtu®x„ (B) zuxt „tuXðÛte
(C) {trn‚e Ëkftu[™ (D) yuf …Ût ™nª

96. r÷™ût{tk VtE÷tu™t sÚÚtt™u yÚtðt ËtuVTxðuh™u rð‚hÛt fhðt {txu ™e[u™t{tkÚte fÞwk Ët{tLÞ {t¤¾wk Au ?
(A) Jar (B) xthƒtu÷
(C) Íe… (D) yuf …Ût ™nª

97. VLC {erzÞt Ã÷uÞh{tk [t÷w xÙuf™tu fw÷ Ë{Þ y™u xÙuf fux÷tu ðt„e [qfÞtu Au ‚u Ë{Þ fÞtk Œþtoððt{tk
ytðu Au ?
(A) MxuxË ƒth (B) Ã÷uÞh ƒth
(C) «„r‚ ÷ûte («tu„úuË) ƒth (D) yuf …Ût ™nª

98. ™e[u™t{tkÚte fÞwk {erzÞt Ã÷uÞh ÷tûtrÛtf‚t™e árüyu Ë{]j Au ?
(A) VAC (B) VEC
(C) VLC (D) VNC

99. ™e[u™t{tkÚte fE ‚fTr™f yt…Ûtt MÚtt™™tu [tu¬Ë ÏÞt÷ yt…u Au ?
(A) GRS (B) GPRS
(C) GRPS (D) GPS

100. ftuE…Ût rðr™Þtu„{tk yûthtu Œt¾÷ fhðt fÞt «tu„út{™tu W…Þtu„ ÚttÞ Au ?
(A) fuhuõxh rzMÃ÷u (B) fuhuõxuh RLËxo
(C) fuhuõxh {u… (D) fuhuõxh rË÷ufx

“Es™uhtu y™u nwL™h Wãtu„tu™t …thk„‚tu …h ™rn …hk‚w rþûtftu …h s Ët[e ËkMf]r‚™tu ytÄth Au.”
– su. f]»ý{qŠ‚– su. f]»ý{qŠ‚– su. f]»ý{qŠ‚– su. f]»ý{qŠ‚– su. f]»ý{qŠ‚
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¢{ {tË «fhý                «fhý™wk ™t{ ykŒtrs‚

™kƒh ‚tË

1. sq™ 1 yÚtoþtMºt{tk yt÷u¾ 19

2 ð]rØ y™u rðftË™t r™Œuoþftu

2. sw÷tE 3 ™týwk y™u Vw„tðtu 27

4 ƒì®Lf„ y™u ™týtfeÞ ™er‚

3. ytì„Mx 5 „heƒe 22

6 ƒuhtus„the

4. ËÃxuBƒh 7 ðM‚e 16

5. ytìõxtuƒh 8 f]r»tûtuºt 12

9 rðŒuþðu…th (y…qýo)

6. ™ðuBƒh 9 rðŒuþðu…th (…qýo) 21

10 Wãtu„ ûtuºt

7. rzËuBƒh 11 ¼th‚eÞ yÚto‚kºt{tk ™q‚™ «&™tu 26

12 «tf]r‚f ¾tãsk„÷ y™u …tfËkhûtý

8. òLÞwythe …w™htð‚o™ 16

9. Vuƒúwythe …w™htð‚o™ 20

“ftuE…ý ht»xÙ™t hûtý y™u rðftË {txu rþûtf, ¾uzq‚ y™u Ëir™f {n¥ð™tk …rhƒ¤tu Au.”
– ÷t÷ƒntŒwh þtMºte– ÷t÷ƒntŒwh þtMºte– ÷t÷ƒntŒwh þtMºte– ÷t÷ƒntŒwh þtMºte– ÷t÷ƒntŒwh þtMºte

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-12  (Ët{tLÞ «ðtn)
rð»tÞ : yÚtoþtMºt (022)

yÇÞtË¢{™wk {tËðth ytÞtus™
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nu‚wytu «{týu „wý¼th :
nu‚wytu ¿tt™ (K) Ë{s (U) W…Þtus™ (A) ËkÞtus™/ftiþÕÞ (S) fw÷
„wý 45 30 20 05 100
xft(%) 45% 30% 20% 05% 100%

«&™™t «fth «{týu „wý¼th :
¢{tkf  «&™tu™t «fth «&™tu™e ËkÏÞt

s™h÷ rðfÕ… rð™t s™h÷ rðfÕ… ËtÚtu fw÷ „wý
1. nu‚w÷ûte «&™tu (O) 20 20 20
2. yr‚ xqkfsðtƒe «&™tu (VSA) 10 10 10
3. xqkfsðtƒe «&™tu (SA-I) 12 16 24
4. xqkfsðtƒe «&™tu (SA-II) 07 10 21
5. ÷tkƒt «&™tu (LA) 05 07 25

                    fw÷ 54 63 100
«fhý ŒeX „wý¼th :

¢{                     …tX/«fhý™wk ™t{   «fhýŒeX „wý¼th
s™h÷ rðfÕ… s™h÷ rðfÕ…

rð™t „wý ËtÚtu „wý
1. yÚtoþtMºt{tk yt÷u¾ 07 10
2. ð]rØ y™u rðftË™t r™Œuoþftu 09 13
3. ™týwk y™u Vw„tðtu 08 10
4. ƒì®Lf„ y™u ™týtfeÞ ™er‚ 08 08
5. „heƒe 10 13
6. ƒuhtus„the 10 12
7. ðM‚e 10 15
8. f]r»tûtuºt 09 10
9. rðŒuþðu…th 07 09
10. Wãtu„ ûtuºt 08 08
11. ¼th‚eÞ yÚto‚kºt{tk ™q‚™ «&™tu 10 13
12. «tf]r‚f ¾tãsk„÷ y™u …tfËkhûtý 04 06

                                         fw÷ 100 127

™tUÄ : yt …rhY… rðãtÚteoytu, rþûtftu, «tr&™ftu, {tuzhuxËo ð„uhu™t {t„oŒþo™ {txu Au. su ‚u rð»tÞtu™t «tr&™f ‚u{s
{tuzhuxËo™u {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtý™t ƒ]nŒT ntŒo/WÆuþ™u ËwËk„‚ hne «&™…ºt™e Ëkh[™t ƒtƒ‚u
VuhVth fhðt™e Aqx hnuþu.

™tUÄ : s™h÷ rðfÕ… ËtÚtu Œþtoðu÷ «&™tu™t „wý ™{q™t™t «&™…ºt «{týu Œþtoðu÷ Au. yLÞ «&™…ºt {txu yt „wý y÷„
ntuE þfu Au.

“Ët[tu rþûtf ð„o¾kz™e Œeðt÷tu™u ytu„t¤e rðï™u ð„o{tk ÷E ytð‚tu ntuÞ Au.” – {™w¼tE …k[tu¤e(‘Œþof’)– {™w¼tE …k[tu¤e(‘Œþof’)– {™w¼tE …k[tu¤e(‘Œþof’)– {™w¼tE …k[tu¤e(‘Œþof’)– {™w¼tE …k[tu¤e(‘Œþof’)

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-12 (Ët{tLÞ «ðtn) rð»tÞ : yÚtoþtMºt (022)
ðtŠ»tf …heûtt

Ë{Þ : 3 f÷tf «&™…ºt™kw …rhY… fw÷ „wÛt : 100
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 «&™ ¢{ rð¼t„ ‚Útt «&™™e rð„‚ „wý

rð¼t„-A

1 Úte 20 ™e[u 1 Úte 20 nu‚w÷ûte «fth™t «&™tu yt…u÷t Au. yt…u÷t rðfÕ…tu{tkÚte ÞtuøÞ 20
rðfÕ… …ËkŒ fhe W¥th ÷¾tu. (Œhuf™tu 1 „wý)

rð¼t„-B

21 Úte 30 ™e[u yt…u÷t 21 Úte 30 «&™tu™t W¥th yuf-ƒu ðtõÞ{tk yt…tu. (Œhuf™tu 1 „wý) 10

rð¼t„-C

31 Úte 46 ™e[u yt…u÷t «&™ ¢{tkf 31 Úte 46 ËwÄe™t 16 «&™tu{tkÚte ftuE…ý 12 (ƒth) 24
«&™tu™t xqkf{tk W¥th ÷¾tu. (Œhuf™t 2 „wý)

rð¼t„-D

47 Úte 56 ™e[u yt…u÷t «&™ ¢{tkf 47 Úte 56 ËwÄe™t 10 «&™tu{tkÚte ftuE…ý 07 (Ët‚) 21
«&™tu™t W¥th {wÆtËh ÷¾tu. (Œhuf™t 3 „wý)

rð¼t„-E

57 Úte 63 ™e[u yt…u÷t «&™ ¢{tkf 57 Úte 63 ËwÄe™t 07 «&™tu{tkÚte ftuE…ý 05 25
(…tk[) «&™tu™t ËrðM‚th W¥th ÷¾tu. (Œhuf™t 5 „wý)

                                                   fw÷ „wý 100

Ëq[™t : rð¼t„–E {tk «&™¢{tkf-63(A) Ët{tLÞ rðãtÚteoytu {txu Au. su{tk ytf]r‚ y™u ‚u™t rð&÷u»tý™u
÷„‚tu «&™ …qAðt™tu hnuþu. (su{tk Ë{Þ ytÄtrh‚ hu¾t ytf]r‚, ËtŒe M‚k¼tf]r‚, …tË-…tËu™e
M‚k¼tf]r‚ fu rð¼trs‚ M‚k¼tf]r‚{tkÚte …qAðt™tu hnuþu.) «&™¢{tkf 63(B) {tºt árüne™ rðãtÚteoytu
{txu hnuþu. su{tk «&™¢{tkf 63(A){tk …qAu÷t «&™™wk {tºt rð&÷u»tý fhðt™wk hnuþu.

“rþûtf {txu Œhuf rŒðË …tu‚t™e ÷tÞft‚ ðÄthðt™e yuf yËtÄthý ‚f Au.”
– ftftËtnuƒ ft÷u÷fh– ftftËtnuƒ ft÷u÷fh– ftftËtnuƒ ft÷u÷fh– ftftËtnuƒ ft÷u÷fh– ftftËtnuƒ ft÷u÷fh

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-12 (Ët{tLÞ «ðtn) rð»tÞ : yÚtoþtMºt (022)
ðtŠ»tf …heûtt

Ë{Þ : 3 f÷tf «&™…ºt™kw {t¤¾wk fw÷ „wÛt : 100
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rð¼t„ - A

• «&™¢{ 1 Úte 20 nu‚w÷ûte «&™tu Au. yt…u÷t rðfÕ…{tkÚte ÞtuøÞ rðfÕ… …ËkŒ fhe sðtƒ ÷¾tu : [20]
(Œhuf «&™™tu 1 „wý Au)

1. ytf]r‚ fÞt «fth™t rð‚hý {txu Œtuhðt{tk ytðu Au ?
(A) rðM‚th (B) Ë‚‚
(C) yË‚‚ (D) ytŒþo

2. ytŠÚtf {trn‚e yk„u™e zuxt CD ftuý ‚iÞth fhu Au ?
(A) þt¤tytu (B) Ët{tLÞ ÔÞÂõ‚ytu
(C) ¾t™„e «ftþftu (D) «Þtu„þt¤tytu, ËkþtuÄ™ fuLÿtu, Ëhfth ð„uhu.

3. {t™ðrðftË™t ytkf™wk {qÕÞ fux÷wk ntuÞ Au ?
(A) yuf (B) þqLÞÚte yuf ðå[u
(C) Ëtu (D) þqLÞ

4. ‘rðftË yux÷u ð]rØ ð¥tt …rhð‚o™’ yt rðÄt™ ftuýu hsq fÞwO Au ?
(A) xtuzuhtu (B) rshtÕz {uÞh
(C) {ufÕt… (D) nuLË™

5. ¼th‚ sYhe …uxÙtur÷Þ{ …uŒtþ™t fux÷t xft sux÷tu …whðXtu ytÞt‚ îtht «tÃ‚ fhu Au ?
(A) 50 (B) 60

(C) 70 (D) 90

6. rhÍðo ƒìLf ytìV RÂLzÞt™e MÚtt…™t fÞt ð»to{tk ÚtE n‚e ?
(A) 1951 (B) 1935

(C) 1947 (D) 1949

• yt «&™…ºt{tk …tk[ rð¼t„ y™u fw÷ 63 «&™tu Au.
• sðtƒ yt…‚tk …nu÷tk «&™tu™u ft¤S…qðof ðtk[e Ëq[™t {wsƒ sðtƒ yt…tu.
• rð¼t„™e Ët{u ftIË{tk ÷¾u÷ ykf „wý Œþtoðu Au.
• ™ðtu rð¼t„ ™ðt …t™t …hÚte s ÷¾ðtu.
• rð¼t„ C, D y™u E{tk s™h÷ rðfÕ… yt…ðt{tk ytÔÞt Au.
• «&™¢{tkf - 63(B) {tºt árüne™ rðãtÚteoytu {txu s Au. su{tk árüne™ rðãtÚteoytuyu {tºt rð&÷u»tý fhðwk.

“rþûtf ¢tkr‚fthe Au, ‚u rðãtÚteoY…e {tæÞ{ îtht Ë{ts y™u ht»xÙ™wk ™ð½z‚h fhe þfu Au.”
– [týõÞ– [týõÞ– [týõÞ– [týõÞ– [týõÞ

„wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtÛt ƒtuzo, „tkÄe™„h
þiûtrýf ð»to - 2025-26

ÄtuhÛt-12 (Ët{tLÞ «ðtn)
rð»tÞ : yÚtoþtMºt (022)

ðtŠ»tf …heûtt
Ë{Þ : 3 f÷tf ™{q™t™wk «&™…ºt fw÷ „wÛt : 100
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7. ËkMf]‚ ¼t»tt «{týu ƒìLf þçŒ™tu yÚto þwk ÚttÞ Au ?
(A) ™týtk™tu …whðXtu (B) {qzehtuftý
(C) {qze™tu sÚÚttuì (D) ÔÞts

8. ð»to 2013{tk ¼th‚{tk ËtiÚte ðÄw „heƒe fÞt htßÞ{tk òuðt {¤e n‚e ?
(A) A¥teË„Z (B) „tuðt
(C) „wsht‚ (D) htsMÚtt™

9. ¾u‚eûtuºtu ¾uzq‚tu™u …tf r™»V¤‚t™t òu¾{Úte hûtý yt…ðt fE Þtus™t þY fhðt{tk ytðe Au ?
(A) NREGA (B) IRDP

(C) PMFBY (D) IAY

10. yËhfthf {tk„™t y¼tðu fÞt «fth™e ƒuhtus„the ËòoÞ Au ?
(A) «åAL™ (B) {tuË{e
(C) ½»toýsLÞ (D) [¢eÞ

11. ƒuhtus„the™t «fthtu ™¬e fhðt {txu™t [th {t…Œkztu ftuýu hsq fÞto Au ?
(A) «tu. …e„w (B) htsf]»ý
(C) fuELË (D) {tþo÷

12. ¼th‚{tk ytÞtus™™tu ythk¼ fE Ët÷{tk ÚtÞtu ?
(A) E.Ë. 1951 (B) E.Ë. 1981
(C) E.Ë. 1991 (D) E.Ë. 2001

13. ¼th‚{tk ™ðe ðM‚e ™er‚ (2000) {txu™e Ër{r‚™e h[™t ftu™t ðz…ý nuX¤ ÚtE n‚e ?
(A) Œe™ŒÞt¤ W…tæÞtÞ (B) s{þuŒS ‚t‚t
(C) ztì. yu{. yuË. Mðt{e™tÚt™T (D) hk„™tÚt™

14. ¼th‚{tk yÄqhe ®Ë[tE Þtus™tytu …qhe fhðt™e sðtƒŒthe ftu™u ËtU…ðt{tk ytðe Au ?
(A) RBI (B) NABARD

(C) RRBs (D) SBI

15. rðŒuþðu…th{tk fÞwk ËtÄ™ ËtiÚte ðÄw „r‚þe÷ Au ?
(A) s{e™ (B) {qze
(C) r™Þtus™þÂõ‚ (D) ©{

16. ÷uýŒuý™e ‚w÷t{tk fux÷tk ¾t‚t ntuÞ Au ?
(A) 1 (B) 2
(C) 3 (D) 4

17. y„hƒ¥te Wãtu„ yu fÞt Wãtu„™wk WŒtnhý Au ?
(A) ™t™t …tÞt™tu Wãtu„ (B) {tuxt …tÞt™tu Wãtu„
(C) „]n Wãtu„ (D) {æÞ{ …tÞt™tu Wãtu„

“¿tt™Y…e …tf ðnU[ðt {txu nwk rþûtf s ƒ™ðt™wk …ËkŒ fhwk.” – Mðt{e ht{‚eÚto– Mðt{e ht{‚eÚto– Mðt{e ht{‚eÚto– Mðt{e ht{‚eÚto– Mðt{e ht{‚eÚto
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18. ònuh ûtuºt yux÷u þwk ?
(A) Ëhfth îtht Ëk[tr÷‚ ûtuºt (B) ytk‚hht»xÙeÞ ûtuºt
(C) ÷tuftu îtht Ëk[tr÷‚ ûtuºt (D) Ënfthð]r¥tðt¤wk ûtuºt

19. ¼th‚{tk hu÷ðu™e Ëti«Út{ þYyt‚ fÞt ð»to{tk ÚtE n‚e ?
(A) 1951{tk (B) 1901{tk
(C) 1853{tk (D) 1875{tk

20. ƒúñt† ƒ™tððt{tk fux÷t r÷xh „ti-{qºt™e sYh …zu Au ?
(A) 20 (B) 50

(C) 30 (D) 10

rð¼t„ - B
• «&™¢{ 21 Úte 30 «&™tu™t W¥th yuf-ƒu ðtõÞ{tk yt…tu : (Œhuf «&™™tu 1 „wý Au.) [10]
21. ð]‚tkþ þtuÄðt™wk Ëqºt ÷¾tu.
22. Sð™™e ¼tir‚f „wýð¥tt ytkf (PQLI) ™e hsqyt‚ ftu™t îtht fhðt{tk ytðe ?
23. «Ät™{kºte s™Ä™ Þtus™t™wk Ëk[t÷™ ftuý fhu Au ?
24. fÞt «fth™e Útt…ýtu ËtiÚte ðÄw ‚h÷ ntuÞ Au ?
25. „heƒe hu¾t yux÷u þwk ?
26. fÞt ðÞsqÚt™u Wí…tŒfeÞ ðÞsqÚt ‚hefu ytu¤¾ðt{tk ytðu Au ?
27. NABARD ™wk …qhwk ™t{ sýtðtu.
28. rðŒuþ ðu…th™wk fŒ yux÷u þwk ?
29. ™t™t …tÞt™t Wãtu„tu fÞt «fth™e Wí…tŒ™ …Ør‚™tu W…Þtu„ fhu Au ?
30. …trh¼tr»tf þçŒ™tu yÚto yt…tu : r{÷ìxTË

rð¼t„ - C
• ™e[u yt…u÷t 31 Úte 46 ËwÄe™t 16 «&™tu{tkÚte ftuE…ý 12 «&™tu™t xqkf{tk W¥th ÷¾tu : [24]

(Œhuf «&™™t 2 „wý)
31. yÚtoþtMºt™t yÇÞtË{tk fBÃÞqxh xìfT™tu÷tìS™t W…Þtu„ ‚hefu …tðh …tuELx «uÍLxuþ™ Ë{òðtu.
32. ELxh™ux™t W…Þtu„™tk ¼ÞMÚtt™tu sýtðtu.
33. ytŠÚtf rðftË™tk ÷ûtýtu sýtðtu. („{u ‚u [th)
34. ytŠÚtf rðftË™tk r™Œuoþftu™t ™t{ sýtðtu.
35. Œtƒu÷tu Vw„tðtu yux÷u þwk ?
36. ™týtk™t «fth sýtðtu.
37. rþzâw÷ ƒìLf™wk ð„eofhý sýtðtu.
38. RBI ™e ™týtfeÞ ™er‚™t „wýtí{f ËtÄ™tu™t {tºt ™t{ sýtðtu.
39. „heƒe™tu ytðf yr¼„{ Ë{òðtu.
40. «åAL™ ƒuhtus„the™tu yÚto yt…tu.
41. …krz‚ Œe™ŒÞt¤ W…tæÞtÞ ©{uð sÞ‚u Þtus™t xqkf{tk Ë{òðtu.
42. ©e htsf]»ý Ër{r‚yu hsq fhu÷ ƒuhtus„the™t {t…Œkztu™t {tºt ™t{ sýtðtu.

“rþûtf yux÷u {qÕÞtu™tu h¾uðt¤, ãtu‚f y™u [trhºÞ îtht [rh‚tÚto fh™th yt[tÞo.” – rð™tuƒt ¼tðu– rð™tuƒt ¼tðu– rð™tuƒt ¼tðu– rð™tuƒt ¼tðu– rð™tuƒt ¼tðu
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43. ¾u‚e™t ytÄwr™fefhý{tk Wãtu„tu fuðe he‚u W…Þtu„e Au ? Ë{òðtu.
44. ¼th‚{tk hu÷ðu Ët{u™t …zfthtu sýtðtu.
45. ¾tãsk„÷ {tìzu÷™t „{u ‚u ƒu VtÞŒt sýtðtu.
46. yÂø™y†™tu W…Þtu„ sýtðtu.

rð¼t„ - D
• ™e[u yt…u÷t 47 Úte 56 ËwÄe™t 10 «&™tu{tkÚte ftuE…ý 07 «&™tu™t W¥th {wÆtËh ÷¾tu : [21]

(Œhuf «&™™t 3 „wý)
47. ytf]r‚ y™u yt÷u¾ Œtuh‚e ð¾‚u æÞt™{tk ht¾ðt™e ƒtƒ‚tu Ë{òðtu.
48. {t™ðrðftË ytkf™t ½xftu Ë{òðtu.
49. ytŠÚtf ð]rØ y™u ytŠÚtf rðftË™tu ‚Vtð‚ ÷¾tu. (ftuE…ý A {wÆt)
50. „heƒe™t ftuE…ý ºtý r™Œuoþftu Ë{òðtu.
51. {ntí{t „tkÄe ht»xÙeÞ „út{eý htus„the „uhkxe Þtus™t ({™hu„t) : xqkf™tUÄ ÷¾tu.
52. ¼th‚{tk ðM‚e r™Þkºtý™t ftuE…ý ºtý W…tÞtu Ë{òðtu.
53. …tf™e VuhƒŒ÷e Ë{òðtu.
54. xqkf™tUÄ ÷¾tu : nqkrzÞt{ý Œh
55. rðŒuþ ðu…th™t fthýtu Ë{òðtu. (ºtý {wÆt)
56. rðrþü ytŠÚtf rðM‚th (SEZ) Ë{òðtu.

rð¼t„ - E
• ™e[u yt…u÷t 57Úte 63 ËwÄe™t 07 «&™tu{tkÚte ftuE…ý 05 «&™tu™t W¥th rðM‚th…qðof yt…tu : [25]

(Œhuf «&™™t 5 „wý)
57. Ëtxt «Útt™tu yÚto yt…e Ëtxt «Útt™e {ÞtoŒtytu Ë{òðtu.
58. ¼th‚{tk „heƒe ½xtzðt™t ytŠÚtf fthýtu Ë{òðtu.
59. {]íÞwŒh™tu yÚto yt…e ™e[tk {]íÞwŒh™tk fthýtu Ë{òðtu.
60. ¼th‚{tk ¾u‚ Wí…tŒf‚t ðÄthðt™t xìfT™tu÷tìSf÷ ËwÄthtytu Ë{òðtu.
61. MÚt¤tk‚h™tu yÚto yt…e MÚt¤tk‚h™e ™fthtí{f yËhtu [[tuo.
62. þnuhefhý™e Ë{MÞt n¤ðe fhðt™t ftuE…ý …tk[ W…tÞtu Ë{òðtu.
63. (A) : Ët{tLÞ rðãtÚteoytu {txu :

¼th‚{tk sL{Œh y™u {]íÞwŒh™e yt…u÷e ytkfztfeÞ {trn‚e™u …tË-…tËu™e M‚k¼tf]r‚{tk hsq
fhe rð&÷u»tý fhtu.
ð»to sL{Œh {]íÞwŒh

(«r‚ 1000 ÔÞÂõ‚yu) («r‚ 1000 ÔÞÂõ‚yu)

1951 39.9 27.4

2011 21.8 7.1

63. (B) : {tºt árüne™ rðãtÚteoytu {txu :

W…htuõ‚ 63(A){tk …qAu÷t «&™™wk {tºt rð&÷u»tý fhðwk.

“rþûtf{tk þiûtrýf ût{‚t ËtÚtu Sð™ «íÞu™tu Wå[ ytŒþo…qýo yr¼„{ …ý ntuðtu òuEyu.”
– ËhŒth ðÕ÷¼¼tE …xu÷– ËhŒth ðÕ÷¼¼tE …xu÷– ËhŒth ðÕ÷¼¼tE …xu÷– ËhŒth ðÕ÷¼¼tE …xu÷– ËhŒth ðÕ÷¼¼tE …xu÷
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{tæÞr{f

rþûtý

…heûtý

y™u

¢{tkf : {W{þƒ/ËkþtuÄ™/2025/2587-2621
„wsht‚ {tæÞr{f y™u
Wå[‚h {tæÞr{f rþûtý ƒtuzo,
Ëìõxh-10ƒe, sq™t Ër[ðt÷Þ …tËu,
„tkÄe™„h. ‚t. 03-09-2025

«r‚,
rsÕ÷t rþûtýtrÄfthe©e (‚{t{),
„wsht‚ htßÞ.

rð»tÞ : þiûtrýf ð»to 2025-26 {txu Ätuhý-10™t rð»tÞ{t¤¾t{tk ðtìfuþ™÷ rþûtý™t rð»tÞ™t
Ë{tðuþ ƒtƒ‚.

ËkŒ¼o : (1) yºtu™tu ‚t. 16-06-2025™tu …ºt ¢{tkf {W{þƒ/ËkþtuÄ™/2025/1712-50
(2) „wsht‚ htßÞ yt[tÞo Ëk½™tu ‚t. 08-08-2025™tu …ºt

W…htuõ‚ rð»tÞ y™u ËkŒ¼o yLðÞu  sýtððt™wk fu rþûtý rð¼t„™t ‚t. 23-10-2024™t …ºt¢{tkf :
ED/other/e-file/3/2024/4095/CHHÚte Ätuhý-10{tk rnLŒe {tæÞ{™e þt¤tytu{tk su rð»tÞtu Au ‚u W…htk‚
ðÄtht™t ytX{t rð»tÞ ‚hefu ðtìfuþ™÷ rþûtý™tu rð»tÞ W{uhðt {txu Ëhfth©e™e {ksqhe {¤u÷ n‚e ‚u{s
Ätuhý-10{tk yLÞ {tæÞ{™e þt¤tytu™t rðãtÚteoytu òu ºteS ¼t»tt y™u ðtìfuþ™÷ rð»tÞ ƒk™u ht¾ðt RåA‚t ntuÞ
‚uðt rðãtÚteoytu MðiÂåAf Ätuhýu Ätuhý-10{tk ytX{t ðÄtht™t rð»tÞ ‚hefu ðtìfuþ™÷ rþûtý™tu rð»tÞ ht¾e þfu
‚u yk„u Ëhfth©e™e {ksqhe {¤u÷ n‚e. su yLðÞu yºtu™t ËkŒ¼o-(1) ŒŠþ‚ ‚t. 16-06-2025™t …ºtÚte yt…™t
‚tƒt nuX¤™e ‚{t{ {tæÞr{f y™u Wå[‚h {tæÞr{f þt¤tytu™u yt rð„‚tu òý ‚Útt y{÷ Ëthw {tuf÷e yt…ðt
{txu sýtððt{tk ytðu÷ n‚wk.

„wsht‚ htßÞ yt[tÞo Ëk½™t ËkŒ¼o-(2) ŒŠþ‚ …ºtÚte yºtu™e f[uhe™u hsqyt‚ {¤u÷ Au. Wõ‚ …ºt{tk Œþtoðu÷
rð„‚u Ätuhý-10{tk ðtìfuþ™÷ rð»tÞ™u ytX{t ({hrsÞt‚) rð»tÞ ‚hefu Œt¾÷ fhðt ËkŒ¼uo „wýtkf™, „wý…ºtf{tk
xtux÷ „wý y™u ytX{t rð»tÞ ‚hefu™t „wý ƒtƒ‚u M…ü‚t Útðt rð™k‚e fhu÷ Au. su yLðÞu sýtððt™wk fu su rðãtÚteoyu
Ätuhý-10{tk ytX{t ðÄtht™t rð»tÞ ‚hefu ðtìfuþ™÷ rð»tÞ ht¾u÷ ntuÞ ‚u rðãtÚteoyu Ätuhý-10™e …heûtt{tk W¥teýo
Útðt {txu ‚{t{ 8 (ytX) rð»tÞtu{tk W¥teýo Útðt™wk hnuþu. ðtìfuþ™÷ rð»tÞ™e nt÷™e òu„ðtE {wsƒ rÚtÞhe™t
30 „wý{tkÚte 10 „wý, «ìÂõxf÷™t 50 „wý{tkÚte 17 „wý y™u ytk‚rhf {qÕÞtkf™™t 20 „wý{tkÚte 06 „wý {u¤ððt™t
hnuþu. fw÷ 100 „wý{tkÚte 33 „wý W¥teýo Útðt {txu {u¤ððt™t hnuþu. su rðãtÚteoyu ytX{tu ðÄtht™t rð»tÞ ‚hefu
ðtìfuþ™÷ rð»tÞ ht¾u÷ ntuÞ ‚u™t „wý…ºtf{tk fw÷ ytX rð»tÞtu™t „wý / „úuz Œþtoððt{tk ytðþu.

W…htuõ‚ rð„‚tu yt…™t ‚tƒt™e ‚{t{ {tæÞr{f þt¤tytu™u òý ‚Útt y{÷ Ëthw {tuf÷e yt…þtu.

ËkÞwõ‚ r™Þt{f
„wsht‚ {tæÞr{f y™u

Wå[‚h {tæÞr{f rþûtý ƒtuzo,
„tkÄe™„h

™f÷ Ërð™Þ hðt™t :
– {t™™eÞ yæÞût©e, „wsht‚ {tæÞr{f y™u Wå[‚h {tæÞr{f rþûtý ƒtuzo, „tkÄe™„h.
™f÷ hðt™t :
– ™tÞƒ r™Þt{f©e, …heûtt (SSC) ‚hV òý ‚Útt sYhe ftÞoðtne Ëthw.
- «{w¾©e, „wsht‚ htßÞ yt[tÞo Ëk½™u òý Ëthw.

ðneðxe rð¼t„

“{t™ð[u‚™t™u s„tze™u ‚u{tk ËkMfthtu™wk ðtðu‚h ‚tu rþûtf s fhe þfu.” - ftŠ‚fuÞ ¼è






